
Käyttöopas

HOIDONHALLINTAOHJELMISTO DIABETEKSEN HOITOON



6025179-034_a

REF MMT-7335

© 2010 Medtronic MiniMed, Inc. Kaikki oikeudet pidätetään.

Paradigm® Veo™ on Medtronic MiniMed, Inc:n tavaramerkki.

Paradigm®, Paradigm Link®, Guardian REAL-Time®, CareLink® ja Bolus Wizard® ovat Medtronic MiniMedin rekisteröityjä tavaramerkkejä.

BD Logic® on Becton, Dickinson and Companyn rekisteröity tavaramerkki.

LifeScan®, OneTouch® UltraLink®, OneTouch® Profile®, OneTouch® Ultra®, OneTouch® UltraSmart®, OneTouch® Basic®, OneTouch® FastTake®, OneTouch® SureStep®, OneTouch® Ultra®
2, OneTouch® UltraMini® ja OneTouch® UltraEasy® ovat LifeScan, Inc:n rekisteröityjä tavaramerkkejä.

Bayer CONTOUR® LINK, Ascensia®, Glucometer®, Ascensia® DEX®, Glucometer® DEX®, Ascensia® DEX® 2, Glucometer® DEX® 2, Ascensia® DEXTER-Z® II, Glucometer® DEXTER-Z®, Ascensia®
ESPRIT® 2, Glucometer® ESPRIT®, Glucometer® ESPRIT® 2,Ascensia ELITE® XL, Glucometer ELITE® XL, Bayer BREEZE™, Bayer BREEZE™ 2 ja Bayer CONTOUR® ovat Bayer Corporationin
Diagnostics Divisionin rekisteröityjä tavaramerkkejä.

Precision Xtra™, Optium Xceed™, Precision Xceed™, Therasense FreeStyle®, FreeStyle® Flash, FreeStyle Mini® ja FreeStyle Papillon™ mini ovat Abbott Laboratories, Inc:n tavaramerkkejä.

ACCU-CHEK® Active, ACCU-CHEK® Aviva, ACCU-CHEK® Compact ja ACCU-CHEK® Compact Plus ovat Roche Groupin rekisteröityjä tavaramerkkejä.

Java™ on Sun Microsystems, Inc:n tavaramerkki.

Microsoft® ja Windows® ovat Microsoft Corporationin rekisteröityjä tavaramerkkejä.

Adobe® ja Acrobat® Reader® ovat Adobe Systems, Inc:n rekisteröityjä tavaramerkkejä.



Yhteystiedot:
Afrikka:
Medtronic Africa (Pty) Ltd.
Puhelin: +27 (0) 11 677 4800

Alankomaat, Luxemburg:
Medtronic B.V.
Puhelin: +31 (0) 45 566 8291
Maksuton: 0800 3422338

Australia:
Medtronic Australasia Pty. Ltd.
Puhelin: 1800 668 670 (tuotetilaukset)
Puhelin: 1800 777 808 (asiakaspalvelu)

Bangladesh
Sonargaon Healthcare Pvt Ltd
Matkapuhelin: (+91) 9903995417
tai (+880) 1714217131

Belgia:
N.V. Medtronic Belgium S.A.
Puhelin: 0800 90805

Brasilia:
Medtronic Comercial Ltda.
Puhelin: +(11) 3707 3707

Espanja:
Medtronic Ibérica S.A.
Puhelin: +34 91 625 05 42
Faksi: +34 91 625 03 90
24 h: +34 901 120 335

Eurooppa:
Medtronic Europe S.A. Euroopan, Lähi-idän ja Afrikan pääkonttori
Puhelin: +41 (0) 21 802 7000

Hongkong:
Celki International Ltd.
Puhelin: +852 2332 3366

Intia:
India Medtronic Pvt. Ltd
Puhelin: (+91) 80 22112245 / 32972359
Matkapuhelin: (+91) 9611633007

Irlanti:
Accu-Science LTD.
Puhelin: +353 45 433000

Israel:
Agentek
Puhelin: +972 3649 3111

Italia:
Medtronic Italia S.p.A.
Puhelin: +39 02 24137 261
Faksi: +39 02 24138 210
Tekninen tuki: Maksuton numero
24 h: 800 712 712

Itävalta:
Medtronic Österreich GmbH
Puhelin: +43 (0) 1 240 44 0
24 h -asiakastuki: 0820 820 190

Japani:
Medtronic Japan Co. Ltd.
Puhelin: +81 3 6430 2019

Kanada:
Medtronic of Canada Ltd.
Puhelin: +1 800 284 4416 (maksuton)

Kiina:
Medtronic (Shanghai) Ltd.
Puhelin: +86 40 0820 1981 
tai +80 0820 1981

Korean tasavalta:
Medtronic Korea, Co., Ltd.
Puhelin: +82 2 3404 3600

Kreikka:
Medtronic Hellas S.A.
Puhelin: +30 210677 9099

Kroatia:
Medtronic Adriatic
Puhelin: +385 1 488 11 20
Faksi: +385 1 484 40 60

Latinalainen Amerikka:
Medtronic, Inc.
Puhelin: 1 (305) 500 9328
Faksi: 1 (786) 709 4244

Latvia:
Ravemma Ltd.
Puhelin: +371 7273780

Lähi-itä ja Pohjois-Afrikka:
Aluetoimisto
Puhelin: +961 1 370 670

Malesia:
Medtronic International Ltd.
Puhelin: +60 3 7953 4800

Norja:
Medtronic Norge A/S
Puhelin: +47 67 10 32 00
Faksi: +47 67 10 32 10

Portugali:
Medtronic Portugal Lda
Puhelin: +351 21 7245100
Faksi: +351 21 7245199

Puerto Rico:
Medtronic Puerto Rico
Puhelin: 787 753 5270

Puola:
Medtronic Poland Sp. Z.o.o.
Puhelin: +48 22 465 6934

Ranska:
Medtronic France S.A.S.
Puhelin: +33 (0) 1 55 38 17 00

Ruotsi:
Medtronic AB
Puhelin: +46 8 568 585 10
Faksi: +46 8 568 585 11

Saksa:
Medtronic GmbH
Geschäftsbereich Diabetes
Puhelin: +49 2159 8149 370
Faksi: +49 2159 8149 110
24 h -asiakastuki: 0800 6464633

Serbia ja Montenegro:
Epsilon
Puhelin: +381 11 311 8883

Singapore:
Medtronic International Ltd.
Puhelin: +65 6436 5097
tai +65 6436 5090

Slovakian tasavalta:
Medtronic Slovakia O.Z.
Puhelin: +421 268 206 944
Faksi: +421 268 206 999

Slovenia:
Zaloker & Zaloker d.o.o.
Puhelin: +386 1 542 51 11
Faksi: +386 1 542 43 32



Sri Lanka:
Swiss Biogenics Ltd.
Matkapuhelin: (+91) 9003077499
tai (+94) 777256760

Suomi:
Medtronic Finland Oy
Puhelin: +358 20 7281 232
Asiakaspalvelu: +358 20 7281 200

Sveitsi:
Medtronic (Schweiz) AG
Puhelin: +41 (0)31 868 0160
24 h -asiakastuki: 0800 633333
Yleinen faksi: +41 (0)318680199

Taiwan:
Medtronic-Taiwan Ltd.
Puhelin: +886 2 2183 6093
Faksi: +886 2 2501 7680
Maksuton: 0800 082 999

Tanska:
Medtronic Danmark A/S
Puhelin: +45 32 48 18 00

Thaimaa:
Medtronic (Thailand) Ltd.
Puhelin: +66 2 232 7400 alanro 1

Turkki:
Medtronic Medikal Teknoloji
Ticaret Ltd. Sirketi.
Puhelin: +90 216 4694330

Tšekin tasavalta:
Medtronic Czechia s.r.o.
Puhelin: (+420 233) 059401

Unkari:
Medtronic Hungária Kft.
Puhelin: +36 1 889 0697

Uusi-Seelanti:
Medica Pacifica
Puhelin: +0800 106 100
24 h -tuki:
+0800 633 487

Venäjä:
Medtronic B. V.
Puhelin: (+7 495) 5807377 x1165
24 h: 8 800 200 76 36

Yhdistynyt kuningaskunta:
Medtronic Ltd.
Puhelin: +44 1923 205167

Yhdysvallat:
Maailmanlaajuinen Medtronic Diabetes -pääkonttori
Puhelin: +1 800 826 2099
24 h -asiakastuki: +1 818 576 5555
Tilaukset: +1 800 843 6687



Sisällys

Luku 1 1 Johdanto
1 Toiminnot
2 Tietoturva
2 Aiheeseen liittyvä dokumentaatio
2 Tuotetuki
2 Tuetut laitteet
4 Tilaaminen
5 Oppaan käyttäminen
5 Käyttöturvallisuus

Luku 2 7 Käytön aloittaminen
7 Ennen kuin aloitat
7 Järjestelmän tärkeimmät tehtävät
8 Siirtyminen järjestelmässä
8 CareLink Pro -ohjelmiston avaaminen
8 Työtilat
9 Työkalurivi
9 Potilasvälilehdet
9 Guide Me -toiminto
10 Guide Me -toiminnon ottaminen käyttöön ja poistaminen

käytöstä
10 Potilastietueiden avaaminen
11 Potilastietueiden sulkeminen
11 Järjestelmäasetusten määrittäminen
12 Yleiset asetukset
13 Potilasprofiilin asetukset
14 Tietokenttien valitseminen
14 Mukautetun kentän lisääminen
14 Tietokenttien järjestyksen muuttaminen
14 Potilasprofiilin asetusten hyväksyminen
14 Potilashaun asetukset
15 Näkyvien tietojen valitseminen
15 Sarakkeiden järjestyksen muuttaminen

CareLink Pro Käyttöopas Sisällys v



15 Potilashaun asetusten hyväksyminen
16 Raporttien luontiasetukset
16 Näkyvien tietojen valitseminen
18 Sarakkeiden järjestyksen muuttaminen
18 Raporttien luontiasetusten hyväksyminen

Luku 3 19 Profile-työtila
19 Ennen kuin aloitat
20 Uusien profiilien lisääminen
20 Potilasprofiilien muokkaaminen
20 Potilastietojen poistaminen järjestelmästä
21 Yhteyden luominen CareLink Personal -tiliin

Luku 4 24 Laitteiston kokoonpano
24 Laitteiden kytkeminen

Luku 5 27 Devices-työtila
28 Ennen kuin aloitat
28 Laitteen lisääminen
28 Medtronic-pumpun tai Guardian-monitorin lisääminen
30 Mittarin lisääminen
33 Laitteen aktivoiminen tai aktivoinnin poistaminen
34 Laitetietojen lukeminen

Luku 6 36 Reports-työtila
36 Ennen kuin aloitat
37 Raporttien luominen
37 Reports-työtilan avaaminen
37 Raportointiajanjakson valitseminen
37 Tietokalenteri
38 Raportteihin sisältyvien lähdetietojen valitseminen
38 Laitetietojen saatavuuden tarkistaminen
39 Ylimääräisten laitetietojen hakeminen
40 Raporttiasetusten tarkistaminen
42 Raporttityyppien ja -päivämäärien valitseminen
42 Raporttien luominen
43 Tietoja raporteista
43 Adherence-raportti
43 Sensor & Meter Overview -raportti
44 Logbook-raportti
44 Device Settings Snapshot -raportti
44 Daily Detail -raportti
44 Tietojen vieminen

Luku 7 46 Järjestelmänvalvonta
46 Ohjelmistopäivitysten asentaminen
47 Automaattisten päivitysilmoitusten poistaminen käytöstä

CareLink Pro Käyttöopas Sisällys vi



47 Päivitysten saatavuuden tarkistaminen manuaalisesti
47 Tietokannan varmuuskopioiminen ja palauttaminen
47 Tietokannan varmuuskopioiminen
48 Tietokannan palauttaminen
48 Kun järjestelmä ei ole käytettävissä

Luku 8 49 Vianetsintä
49 Sovelluksen yleiset käyttövirheet
49 Ei tietokantayhteyttä
50 CareLink Pro -ohjelmiston laitoksen salasana unohtunut
50 Laitteiden lukuvirheet
51 Raporttien luontivirheet
51 Varmuuskopioimisen ja palauttamisen virheet
51 Ohjelmiston poistaminen

Luku 9 53 Kuvaketaulukko

Liite A 54 CSV-tiedot
54 Sarakkeiden tietojen kuvaukset
56 Lisätietoja CareLink Pro -ohjelmistolla tallennetuista CSV-

tiedostoista
56 Poikkeamat tietojen odotetusta järjestyksestä

Sanasto 57

Hakemisto 60

CareLink Pro Käyttöopas Sisällys vii



CareLink Pro Käyttöopas Sisällys viii



1

Johdanto

Kiitos valinnastasi tehdä yhteistyötä Medtronic Diabeteksen kanssa parantaaksesi  potilaittesi

diabeteksen hoidon hallintaa. Uskomme, että CareLink® Pro -ohjelmiston huipputekniikasta ja

helppokäyttöisestä  valikkopohjaisesta käyttöliittymästä on sinulle hyötyä.

CareLink-ohjelmiston avulla voit kerätä, tallentaa ja raportoida potilaiden hoito- ja

diagnosointitietoja. Sen avulla voit myös käyttää pumpun, verensokerimittarin ja

glukoosisensorin tietoja, jotka potilaat ovat ladanneet CareLink® Personal -järjestelmään. Se

on www-pohjainen hoidonhallintajärjestelmä, joka toimii  CareLink Pro -ohjelmiston kanssa.

Toiminnot

CareLink Pro on diabeteksen hoidossa käytettävä hoidonhallintaohjelmisto PC-tietokoneelle.

Se sisältää muun muassa seuraavat toiminnot:

• Potilaan laitteesta ja CareLink Personal -tilistä haetut hoitotiedot voidaan tallentaa

potilastietueisiin.

• Insuliinipumppujen, monitorien ja verensokerimittareiden tiedot voidaan lähettää ja tallentaa

järjestelmään, ja niistä voidaan luoda raportteja.

• Ohjelmistoa voidaan käyttää valinnaisen CareLink Personal -järjestelmän kanssa, jolloin saat

käyttöösi potilaiden omaan tiliinsä tallentamat tiedot. Näin voit luoda ajantasaisia raportteja

vastaanottokäyntien välillä eikä laitetietoja tarvitse välttämättä lukea vastaanottokäynnin

aikana.

• Potilastietueeseen tallennetuista laitetiedoista voidaan luoda erilaisia hoitoraportteja.

Raporttien avulla voit selvittää potilaan hoitoon liittyviä asioita, kuten omahoidon

onnistumisen ja verensokeriarvojen vaihtelumallit ja poikkeamat.

• Järjestelmä ilmoittaa, kun ohjelmistopäivityksiä on ladattavissa ja asennettavissa. Näin saat

käyttöösi uusimmat toiminnot.

• CareLink Pro -ohjelmistossa on uusille käyttäjille tarkoitettu Guide Me -toiminto. Se antaa

ohjeita ja vinkkejä parhaillaan suoritettavista toiminnoista.
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• Ohjelmiston kaikissa osissa on käytettävissä kiinteä käytönaikainen ohje, joka sisältää tietoja

eri aiheista.

Tietoturva

• CareLink Pro voidaan suojata salasanalla.

• CareLink Personal -ohjelmistosta siirrettävät potilastiedot salataan teollisuusstandardin

mukaisella Secure Sockets Layer (SSL) -protokollalla.

Aiheeseen liittyvä dokumentaatio

Seuraavat Medtronic MiniMedin oppaat sisältävät laitekohtaisia tietoja, joita ei käsitellä

tarkasti tässä käyttöoppaassa.

HUOMAUTUS: Katso muiden valmistajien mittareiden käyttöohjeet mittareiden mukana
toimitetuista oppaista.

• Paradigm-insuliinipumpun käyttöopas

• Guardian REAL-Time -monitorin käyttöopas

• Sensorin toiminnot

• ComLink-käyttöopas

• CareLink-USB-laitteen käyttöopas.

Tuotetuki

Jos tarvitset lisäohjeita järjestelmän käytössä, ota yhteys oman maasi paikalliseen edustajaan.

Kansainväliset yhteystiedot ovat seuraavassa www-sivustossa:

http://www.medtronicdiabetes.com/help/contact/locations.html

Tuetut laitteet

CareLink Pro -ohjelmisto pystyy vastaanottamaan tiedot seuraavista laitteista.

HUOMAUTUS: Joitakin ohjelmiston tukemia laitteita ei ehkä ole saatavilla kaikissa

maissa, joissa ohjelmisto on hyväksytty käyttöön.
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Insuliinipumput/glukoosimonitorit

Medtronic MiniMed -pumput: 508

Medtronic MiniMed Paradigm® -sarjan pumput: 511, 512, 712, 515, 715, 522,  722, 522K, 722K,
Paradigm® Veo™ (554, 754)

Guardian REAL-Time -monitorit:
CSS-7100

CSS-7100K

Valmistaja Verensokerimittarit

Medtronic Diabetes -yhteistyökumppanien laitteet:
• Bayer CONTOUR® LINK

• BD Paradigm Link® -verensokerimittari

LifeScan:

• OneTouch® UltraSmart®

• OneTouch® Profile®

• OneTouch® Ultra®

• OneTouch® Basic®

• OneTouch® FastTake®

• OneTouch® SureStep®

• OneTouch® Ultra® 2

• OneTouch® UltraMini®

• OneTouch® UltraEasy®

Bayer:

• Ascensia BREEZE®

• BREEZE® 2

• CONTOUR®

BD: • Logic®

Bayer Ascensia® DEX® -sarja, mukaan lukien nämä
yhteensopivat mittarit:

• Ascensia® DEX®

• Ascensia® DEX® 2

• Ascensia® DEXTER-Z® II

• Glucometer® DEXTER-Z®

• Ascensia® ESPRIT® 2

• Glucometer® ESPRIT®

• Glucometer® ESPRIT® 2

Bayer Ascensia ELITE™ -sarja, mukaan lukien nämä
yhteensopivat mittarit:

• Ascensia ® ELITE™

• Glucometer ELITE® XL

Abbott:

• FreeStyle®

• FreeStyle® Lite®

• FreeStyle® Freedom®

• FreeStyle® Freedom Lite®

• Precision Xtra™

• TheraSense FreeStyle®

• FreeStyle® Flash®

• FreeStyle® Papillon™ mini

• FreeStyle® Mini®

• Optium Xceed™

• Precision Xceed™

Roche:

• Accu-Chek® Aviva

• Accu-Chek® CompactPlus

• Accu-Chek® Compact

• Accu-Chek® Active
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Tiedonsiirtolaitteet

Com-Station
Tarkoitettu käytettäväksi Medtronic MiniMed 508
−pumpun kanssa. (Katso Com-Station-
käyttöoppaasta lisätiedot laitteistovaatimuksista.)

ComLink

Tarkoitettu käytettäväksi MiniMed Paradigm
−pumpun ja Guardian REAL-Time -monitorin
kanssa. (Katso ComLink-käyttöoppaasta lisätiedot
laitteistovaatimuksista.)

Paradigm Link® -verensokerimittari

Tarkoitettu käytettäväksi MiniMed Paradigm -
pumpun tai Guardian REAL-Time -monitorin
kanssa. (Katso Paradigm Link®
−verensokerimittarin käyttöoppaasta lisätiedot
laitteistovaatimuksista.)

CareLink®-USB-laite
Tarkoitettu käytettäväksi MiniMed Paradigm
−sarjan insuliinipumpun ja Guardian REAL-Time
−monitorin kanssa.

Tiedonsiirtokaapeli

Tarkoitettu käytettäväksi kolmansien osapuolien
verensokerimittareiden kanssa. Mittarin
valmistajat toimittavat tiedonsiirtokaapelin
mittarin mukana.

Huomautus: Jos mittarin valmistaja toimittaa
sarjakaapelin sijasta USB-kaapelin tietojen
latausta varten, sinun on asennettava valmistajan
toimittama ohjelmisto-ohjain.

Tarkista lisäksi mittarin valmistajalta, että USB-
ohjain on yhteensopiva käyttöjärjestelmäsi
kanssa. Joitakin USB-ohjaimia ei ehkä ole
saatavilla 64-bittisiin järjestelmiin.

Vastaavat laitteet

Kun lisäät järjestelmään laitteen, sinun on valittava sen merkki ja malli  luettelosta. Jos

laitteen merkki ja malli eivät ole luettelossa, käytä seuraavassa taulukossa lueteltuja

vastaavia laitteita.

Potilaan käyttämä laite Valittava laite

• Bayer Ascensia® DEX® 2

• Bayer Ascensia® DEXTER-Z® II

• Bayer Glucometer® DEXTER-Z®

• Bayer Ascensia® ESPRIT® 2

• Bayer Glucometer® ESPRIT®

• Bayer Glucometer® ESPRIT® 2

Bayer Ascensia® DEX®

Bayer Glucometer ELITE® XL Bayer Ascensia ELITE™

Precision Xceed™ Optium Xceed™

Tilaaminen

Tilaa Medtronic Diabetes -tuotteita oman maasi paikalliselta edustajalta. Kansainväliset

yhteystiedot ovat seuraavassa URL-osoitteessa:

http://www.medtronicdiabetes.com/help/contact/locations.html
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HUOMAUTUS: Mittarit voidaan tilata niiden valmistajilta.

Oppaan käyttäminen

HUOMAUTUS: Käyttöopas sisältää esimerkkejä ohjelmiston näytöistä. Ohjelmiston näytöt

voivat olla todellisuudessa hiukan erilaisia.

Sanasto sisältää termien ja toimintojen määritelmiä. Seuraavassa taulukossa on selitetty

oppaassa käytetyt merkinnät.

Termi/tyyli Merkitys

Napsauta Valitse näytön kohde painamalla hiiren
ykköspainiketta kohteen kohdalla.

Kaksoisnapsauta Avaa näytön kohde painamalla hiiren
ykköspainiketta kaksi kertaa kohteen kohdalla.

Napsauta hiiren kakkospainikkeella Avaa toinen ikkuna tai  valikko painamalla hiiren
kakkospainiketta näytön kohteen kohdalla.

Lihavoitu  teksti
Painike, näytön nimi, kentän nimi tai
valikkovaihtoehto. Esimerkki:  Patient > New
Patient

HUOMAUTUS: Lisätietoja toimenpiteestä tai vaiheesta.

VAROITUS:
Varoittaa mahdollisesta vaaratilanteesta, joka voi
johtaa vähäisiin tai melko vakaviin ohjelmisto- tai
laitevaurioihin.

VAARA:
Varoittaa mahdollisesta vaaratilanteesta, joka voi
johtaa kuolemaan tai vakaviin vammoihin. Se voi
myös selittää mahdollisia vakavia haittavaikutuksia
ja vaaratilanteita.

Käyttöturvallisuus

Käyttöaiheet

CareLink Pro -järjestelmä on tarkoitettu diabeteksen hoidon hallinnan apuvälineeksi.

Järjestelmän tarkoitus on vastaanottaa tietoja insuliinipumpuista, verensokerimittareista ja

jatkuvatoimisista glukoosimonitorointijärjestelmistä ja muuntaa tiedot CareLink Pro

−raporteiksi.  Raportit sisältävät tietoja, joiden avulla voidaan tunnistaa trendejä ja seurata

potilaan päivittäisiä toimia, kuten nautittua hiilihydraattimäärää, ateria-aikoja, insuliinin

annostelua ja glukoosiarvoja.

Vaarat

• Järjestelmä on tarkoitettu diabeteksen hoitoon perehtyneiden terveydenhoidon

ammattilaisten käyttöön.

CareLink Pro Käyttöopas   Johdanto 5



• Järjestelmän tulosten tarkoitus ei ole antaa lääketieteellisiä toimintaohjeita, eikä niitä saa

käyttää sellaiseen tarkoitukseen.

• Ohjelmistoa saa käyttää vain tässä oppaassa lueteltujen tuettujen laitteiden kanssa. (Katso

kohta Tuetut laitteet sivulla 2.)

• Potilaita tulee kehottaa mittaamaan verensokeri vähintään 4–6 kertaa päivässä.

• Potilaille on muistutettava, että he eivät saa muuttaa hoitoaan kysymättä ensin neuvoa

terveydenhoidon ammattilaiselta.

• Potilaiden tulee tehdä hoitopäätöksiä terveydenhoidon ammattilaisten ohjeiden ja mittarin

verensokeriarvojen perusteella, ei glukoosisensorin tulosten perusteella.

Vasta-aiheet

Ohjelmiston kanssa ei saa käyttää laitteita, joita ei ole lueteltu kohdassa Tuetut laitteet sivulla 2.

Ohjelmistoa ei  saa myöskään käyttää muiden tilojen kuin diabeteksen hoitoon.

Ennen kuin avaat ohjelmiston, sulje kaikki seuraavat ohjelmistot, jos ne ovat käynnissä:

• CGMS® System Solutions™ -ohjelmisto (7310)

• Solutions® Pumps & Meters -ohjelmisto (7311)

• Guardian® Solutions® -ohjelmisto (7315)

• ParadigmPAL™ (7330)

• CareLink® Personal -ohjelmisto (7333)

• CGMS®iPro-järjestelmän Solutions®-ohjelmisto (7319).
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Käytön aloittaminen

Seuraavissa kohdissa kuvataan CareLink Pro -ohjelmiston käynnistäminen, potilastietueiden

avaaminen ja sulkeminen sekä kaikkia järjestelmän potilaita koskevien asetusten

määrittäminen.

Ennen kuin aloitat

Jos käytät CareLink Pro -järjestelmää ensimmäisen kerran, määritä ensin yleiset asetukset

(katso kohta Yleiset asetukset sivulla 12). Nämä asetukset määrittävät tiettyjen tietojen

esitystavan ohjelmistossa ja raporteissa sekä järjestelmän Internet-yhteyttä käyttävät

toiminnot.

Asetukset voidaan määrittää milloin tahansa. On ehkä parasta tutustua CareLink Pro

−ohjelmistoon, ennen kuin määrität muut asetukset.

Järjestelmän tärkeimmät tehtävät

Seuraavassa taulukossa on kuvattu päätehtävät, jotka on suoritettava CareLink Pro

−ohjelmiston ensimmäisellä määritys- ja käyttökerralla.  Taulukossa on myös käyttöoppaan

kohta, jossa kukin tehtävä kuvataan.

Tehtävä Kohta

Tutustu CareLink Pro -ohjelmiston käyttöliittymään. Siirtyminen järjestelmässä sivulla 8

Määritä yleiset järjestelmäasetukset, joita laitos käyttää. Järjestelmäasetusten määrittäminen sivulla 11

Luo profiilit kaikille potilaille. Uusien profiilien lisääminen sivulla 20

Luo yhteys potilaiden CareLink Personal -tileihin. Yhteyden luominen CareLink Personal -tiliin
sivulla 21

Lisää pumppu ja mittarit  potilaiden profiileihin. Laitteen lisääminen sivulla 28

Lue tiedot potilaiden pumpusta ja mittareista. Laitetietojen lukeminen sivulla 34

Määritä ja luo raportit kaikille potilaille. Raporttien luominen sivulla 37
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Tehtävä Kohta

Varmuuskopioi CareLink Pro -tietokanta säännöllisesti. Tietokannan varmuuskopioiminen sivulla 47

Päivitä CareLink Pro -ohjelmisto. Ohjelmistopäivitysten asentaminen sivulla 46

Siirtyminen järjestelmässä

Tutustu käyttöliittymään, ennen kuin alat työskennellä CareLink Pro -ohjelmiston kanssa.

Käyttöliittymä sisältää valikoita, työkalurivin, siirtymispalkin, työtiloja ja Guide Me -ikkunan.

CareLink Pro -ohjelmiston avaaminen

1 Kaksoisnapsauta tietokoneen työpöydän CareLink Pro -kuvaketta  tai napsauta

Windowsin Start-painiketta, valitse Programs ja sitten Medtronic CareLink Pro.

Jos laitos edellyttää salasanan syöttämistä, näkyviin tulee kirjautumisnäyttö.

a. Kirjoita salasana Password-kenttään.

HUOMAUTUS: Salasanan syöttäminen on valinnainen toiminto, joka määritetään
asennuksen yhteydessä.

b. Napsauta LOGIN-painiketta.

Näkyviin tulee aloitusnäyttö.

2 Jos haluat luoda uuden potilastietueen, napsauta New Patient  -painiketta. Jos haluat avata

järjestelmän potilasluettelossa olevan potilastietueen, napsauta Open Patient -painiketta.

Työtilat

Jos potilastietue on avoinna, saat näkyviin haluamasi työtilan napsauttamalla siirtymispalkin

vastaavaa painiketta. Näissä työtiloissa voit syöttää tai  valita tietoja potilaalle suoritettavia

CareLink Pro -tehtäviä varten.

Profile: Tässä työtilassa voit muokata
tallennettuja potilastietoja, kuten nimeä ja
syntymäaikaa. Tässä työtilassa voit myös luoda
yhteyden potilaan CareLink Personal -tiliin.

Devices: Tässä työtilassa voit tallentaa tiedot,
joita tarvitaan potilaan laitetietojen luvussa.

Reports: Tässä työtilassa voit valita parametrit
ja potilaalle luotavat raportit.

Ennen kuin olet lisännyt ja tallentanut potilaalle profiilin, ainoa potilaalla käytettävissä oleva

työtila on Profile.  Ennen kuin olet lisännyt potilaalle laitteita, ainoat potilaalla käytettävissä

olevat työtilat ovat Profile ja Devices.
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Työkalurivi

CareLink Pro -työkalurivin avulla voit valita nopeasti useimmin käytettävät toiminnot.

Työkalurivi sisältää seuraavat painikkeet.

Painike Nimi Toiminto

Add Patient
Avaa Profile-työtilan, jossa voit
lisätä järjestelmään uuden
potilastietueen.

Open Patient

Avaa Patient Lookup -taulukon,
jossa voit tarkastella haluamaasi
olemassa olevaa
potilastietuetta.

Guide Me

Näyttää tai piilottaa Guide Me
−ikkunan. Saat näyttöön
tilannekohtaiset ohjeet
painiketta napsauttamalla.

Potilasvälilehdet

Kun avaat potilastietueen, näytön työkalurivin alle tulee välilehti,  jossa lukee potilaan nimi.

Kun välilehti on aktiivinen, potilastietue ja työtila ovat aktiivisia ja voit suorittaa potilaalle

CareLink Pro -tehtäviä.

Voit aktivoida haluamasi potilaan potilastietueen käsittelyä varten napsauttamalla kyseisen

potilaan välilehteä. Voit sulkea potilastietueen napsauttamalla välilehden sulkemis-

painiketta .

Guide Me -toiminto

Guide Me -toiminto on käytettävissä CareLink Pro -ohjelmiston kaikissa osissa. Toiminto avaa

tilannekohtaisia ohjeita ja vinkkejä sisältävän ikkunan toiminnoista, joita saatat käyttää

järjestelmän aktiivisessa osassa. Guide Me -ikkunat voivat sisältää myös >> learn more
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−linkkejä. Linkkejä napsauttamalla pääset käytönaikaisen ohjeen vastaaviin aiheisiin ja

lisätietoihin. Guide Me -toiminto on käytössä oletusarvoisesti. Voit kuitenkin poistaa

toiminnon käytöstä milloin tahansa.

Guide Me -toiminnon ottaminen käyttöön ja poistaminen käytöstä

Voit ottaa Guide Me -toiminnon käyttöön tai poistaa sen käytöstä seuraavasti:

• Napsauta Guide Me  -painiketta .

• Valitse Help  > Guide Me.

Potilastietueiden avaaminen

Samanaikaisesti  voi olla avoinna enintään kuusi potilastietuetta. Jos et ole vielä luonut

potilasprofiileja, katso kohta Uusien profiilien lisääminen sivulla 20.

1 Valitse File > Open Patient  tai napsauta Open Patient  -painiketta . Näyttöön tulee

seuraavankaltainen potilasluettelo.
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HUOMAUTUS: Jos näyttöön tulee viesti, jonka mukaan liian monta potilastietuetta on

avoinna, valitse OK, sulje yksi tietue ja jatka.

2 Etsi potilas luettelosta kirjoittamalla potilaan nimi tai osa nimestä Find a Patient  -kenttään.

Kun potilaan rivi on korostettuna luettelossa, avaa potilastietue napsauttamalla OPEN-

painiketta tai kaksoisnapsauttamalla riviä tai painamalla ENTER-näppäintä. Voit myös selata

luetteloa käyttämällä näppäimistön ylä- ja alanuolinäppäimiä.

Näyttöön tulee potilaan Devices-työtila (jos potilaalle ei ole vielä lisätty laitteita) tai Reports-

työtila.

3 Voit avata potilaan Profile-työtilan napsauttamalla siirtymispalkin Profile-painiketta .

Potilastietueiden sulkeminen

1 Varmista, että suljettava potilastietue on aktiivinen (välilehti on korostettu).

2 Toimi jommallakummalla tavalla:

a. Valitse File > Close Patient.

b. Napsauta potilasvälilehden sulkemispainiketta .

c. Paina pikanäppäintä Ctrl+F4.

Järjestelmäasetusten määrittäminen

Nämä asetukset koskevat järjestelmän kaikkia potilaita. Lisätietoja potilaskohtaisista

asetuksista on kohdassa Raporttiasetusten tarkistaminen sivulla 40.

Asetukset on jaettu seuraaviin ryhmiin:

• General

- Glucose Units

- Carbohydrate Units

- Communications

- Troubleshooting

• Patient Profile

- Valitse ja järjestä potilasprofiilien tietokentät.

• Patient Lookup

- Muokkaa kenttiä ja muuta kenttien esitysjärjestystä sen mukaan, miten haluat niiden

näkyvän, kun avaat potilasluettelon valitsemalla Open Patient.

• Report Generation

- Valitse tietokentät, joiden haluat näkyvän tietotaulukossa, jonka perusteella valitaan

Daily Detail -raportin sisältö.
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Yleiset asetukset

General-välilehdessä voit määrätä, missä muodossa tietyt tiedot näkyvät ohjelmistossa, ja

valita ulkoisten yhteyksien asetukset.

1 Jos välilehti ei ole jo aktiivinen, napsauta General-välilehteä.

2 Valitse Tools > Options.  Näyttöön tulee seuraava ikkuna.

3 Valitse haluamasi vaihtoehdon valintanappi:

- Glucose Units:  mg/dL tai mmol/L

- Carbohydrate Units:  grams tai Exchanges

a. Jos valitset Carbohydrate Units -asetukseksi Exchanges,  kirjoita grams are equal to 1

Exchange -kenttään, kuinka monta grammaa vastaa yhtä vaihtoannosta.

4 Valitse napsauttamalla Chart Options > Overview Report -osion valintaruutu tai poista sen

valinta. Jos valintaruutu on valittuna, sovellus yhdistää Meter Glucose Overlay -kaavion

verensokeriarvot viivoilla. (Tämä kaavio näkyy Sensor & Meter Overview -raportissa.)

5 Voit ottaa käyttöön tai poistaa käytöstä seuraavat Communications-osion asetukset

valitsemalla valintaruudun tai poistamalla sen valinnan:

HUOMAUTUS: Noudata sairaalan tai IT-osaston ohjeita, kun määrität Internet-yhteyttä
käyttävien toimintojen asetukset.
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- Automatically check for software updates:  Jos valitset tämän vaihtoehdon, kaikkiin

tietokoneisiin, joissa CareLink Pro on käynnissä, lähetetään ilmoitus saatavilla olevista

ohjelmistopäivityksistä. Aktiivisella käyttäjällä on tällöin mahdollisuus ladata ja asentaa

päivitykset. Jos haluat estää tämän ja jakaa ohjelmistopäivitykset ohjatusti, poista

valintaruudun valinta.

- Synchronize with Medtronic CareLink® Personal: Jos haluat synkronoida järjestelmän

automaattisesti potilaiden CareLink Personal -tilin tietojen kanssa aina, kun avaat heidän

profiilinsa, valitse tämä valintaruutu. Jos poistat valintaruudun valinnan, sinun on

synkronoitava kunkin potilaan CareLink Personal -tilin tiedot manuaalisesti.

6 Valitse napsauttamalla Troubleshooting-osion valintaruutu tai poista sen valinta. Jos

valintaruutu on valittuna, sovellus tallentaa luvun yhteydessä laitteen asetukset vianetsintää

varten.

7 Tallenna yleiset asetukset napsauttamalla OK-painiketta.

Potilasprofiilin asetukset

Tämä on yleinen asetus, joka määrää profiilien sisällön. Voit mukauttaa Profiles-työtilan

kenttiä niin, että potilasprofiili  sisältää laitoksen toiminnan kannalta tärkeimmät tiedot. Voit

lisätä tai  poistaa kenttiä, luoda omia mukautettuja kenttiä ja määrätä ikkunassa näkyvien

tietojen järjestyksen.

1 Valitse Tools > Options.

2 Napsauta Patient Profile  -välilehteä. Näyttöön tulee seuraava ikkuna.

HUOMAUTUS: Valitse profiiliin haluamasi kentät valitsemalla kenttien valintaruudut.

Järjestä kentät haluamaasi järjestykseen ylä- ja alanuolipainikkeilla.
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Tietokenttien valitseminen

1 Lisää haluamasi kentät valitsemalla niiden valintaruudut.

HUOMAUTUS: First Name- ja Last Name -kenttää ei voi poistaa.

2 Voit poistaa kentän profiilista poistamalla sen valintaruudun valinnan.

3 Voit määrittää kentän pakolliseksi valitsemalla Required-sarakkeen valintaruudun. Pakolliset

kentät on täytettävä profiilia luotaessa.

Mukautetun kentän lisääminen

1 Valitse tyhjän mukautetun kentän vasemmalla puolella oleva valintaruutu.

2 Kirjoita kentän nimi (esimerkiksi ”Yhteyshenkilö hätätapauksessa”). Tämä teksti näkyy kentän

nimenä potilasprofiilissa.

3 Voit määrittää kentän pakolliseksi valitsemalla Required-sarakkeen valintaruudun.

HUOMAUTUS: Voit poistaa mukautetun kentän profiilista poistamalla kentän vieressä

olevan valintaruudun valinnan.

Tietokenttien järjestyksen muuttaminen

Valitse siirrettävä kenttä ja siirrä sitä napsauttamalla ylä- tai alanuolipainiketta . (Ylin ja

alin nuolipainike siirtävät kentän koko luettelon alkuun tai loppuun.)

Potilasprofiilin asetusten hyväksyminen

Kun Field Order -luettelo sisältää kaikki haluamasi kentät oikeassa järjestyksessä, napsauta OK-

painiketta.

Potilasprofiilit sisältävät nyt valitsemasi kentät valitsemassasi järjestyksessä.

Potilashaun asetukset

Patient Lookup -taulukon avulla haetaan ja avataan potilastietueita. Taulukossa on jokainen

tietokannan sisältämä potilas ja potilasprofiilin tunnistetiedot. Voit tarvittaessa valita, mitä tietoja

taulukossa näkyy, ja mukauttaa sarakkeiden järjestystä. Voit mukauttaa Patient Lookup

−taulukkoa seuraavasti:

1 Valitse Tools > Options.
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2 Napsauta Patient Lookup -välilehteä. Näyttöön tulee seuraava ikkuna.

HUOMAUTUS: Valitse Patient Lookup -taulukkoon haluamasi tiedot valitsemalla

niiden valintaruudut. Järjestä sarakkeet haluamaasi järjestykseen ylä- ja

alanuolipainikkeilla.

Näkyvien tietojen valitseminen

Valitse Patient Lookup -taulukossa näkyvät tiedot valitsemalla niiden valintaruutu tai  poista

tiedot poistamalla valintaruutujen valinta.

Sarakkeiden järjestyksen muuttaminen

Voit muuttaa Patient Lookup -taulukon sarakkeiden järjestystä valitsemalla siirrettävän

sarakkeen ja napsauttamalla ylä- ja alanuolipainikkeita .  (Ylin ja alin nuolipainike siirtävät

tietosarakkeen koko luettelon alkuun tai loppuun.)

Column Display Order -luettelon ylin tietosarake näkyy Patient Lookup -taulukon

ensimmäisenä sarakkeena. Alin tietosarake näkyy taulukon viimeisenä sarakkeena.

Potilashaun asetusten hyväksyminen

Kun Column Display Order -luettelo sisältää kaikki  haluamasi tiedot oikeassa järjestyksessä,

napsauta OK-painiketta.

Patient Lookup -taulukko sisältää nyt valitsemasi tiedot valitsemassasi sarakejärjestyksessä.
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Raporttien luontiasetukset

Tietotaulukko näkyy Select and Generate Reports -ikkunassa. Taulukkoa käytetään

raportoinnin aikana. Se sisältää vuorokausikohtaiset tiedot, jotka on saatu potilaan laitteista

ja CareLink Personal -ohjelmiston tilistä, jos potilaalla on tili.  Taulukon sisältämät tiedot

auttavat päättämään, miltä vuorokausilta on luotava Daily Detail -raportti. Sen avulla voit

myös päättää, mitä muita raportteja kannattaa luoda.

Laitos voi mukauttaa taulukossa näkyviä tietoja, kuten tietojen esitysjärjestystä, sen mukaan,

mikä on olennaisinta laitoksen toiminnan kannalta.

HUOMAUTUS: Kohdassa Raporttityyppien ja -päivämäärien valitseminen sivulla 42  on

kuvattu, miten nämä asetukset vaikuttavat tietotaulukkoon raporttien luonnin aikana.

1 Valitse Tools > Options.

2 Napsauta Report Generation -välilehteä. Näyttöön tulee seuraava ikkuna.

Näkyvien tietojen valitseminen

Valitse tietotaulukkoon haluamasi tiedot valitsemalla niiden valintaruudut tai  poista tiedot

taulukosta poistamalla valintaruutujen valinta.

Tietotaulukkoon voidaan valita seuraavat tiedot.

Sarakkeen nimi Kuvaus

№ of Meter Readings Raporttiin sisällytetyillä laitteilla tallennettujen
arvojen lukumäärä kyseisenä vuorokautena.

Meter Readings Average Raporttiin sisällytetyillä laitteilla tallennettujen
glukoosiarvojen keskiarvo.
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Sarakkeen nimi Kuvaus

Sensor Duration
Ajanjakso, jolta sensoritietoja tallennettiin kyseisenä
vuorokautena. Mahdollisia arvoja ovat --  (ei mitään),
0:05–24:00.

Sensor Average Kyseisenä vuorokautena tallennettujen
sensoriarvojen keskiarvo.

Highest Reading Kyseisen vuorokauden korkein glukoosiarvo
(sensorista tai mittarista saatu).

Lowest Reading Kyseisen vuorokauden matalin glukoosiarvo
(sensorista tai mittarista saatu).

Avg AUC Below Target AUC-keskiarvo, joka kuvaa potilaan tavoitealueen
alapuolella olevia arvoja.

Avg AUC Above Target AUC-keskiarvo, joka kuvaa potilaan tavoitealueen
alapuolella olevia arvoja.

Total Carbs

Kyseisenä vuorokautena raportoitujen
hiilihydraattimäärien summa (mittayksikön mukaan
pyöristettynä lähimpään grammaan tai lähimpään
vaihtoannosarvoon 0,1 vaihtoannoksen
tarkkuudella).  Hiilihydraattimäärät saadaan pumpun
tai Guardian-monitorin Bolus Wizard -tapahtumista
tai hiilihydraattimerkeistä.

Suspend Duration
Aika, jonka pumppu oli pysäytettynä kyseisenä
vuorokautena. Mahdollisia arvoja ovat --  (ei tietoja),
0:01–24:00.

№ of Rewinds Kerrat, joina pumppu palautettiin alkuasentoon
kyseisenä vuorokautena.

№ of Primes/Fills Täyttötapahtumien lukumäärä kyseisenä
vuorokautena.

Prime/Fill Volume (U) Täyttötapahtumissa käytetyn insuliinin
kokonaismäärä kyseisenä vuorokautena.

Total Insulin (U) Pumpun tallentama insuliinin kokonaismäärä, joka
on annosteltu kyseisenä vuorokautena.

Total Basal  (U)

Perusinsuliinin kokonaismäärä, joka on annosteltu
kyseisenä vuorokautena (saadaan vähentämällä
insuliinin kokonaismäärästä kaikkien lisäannosten
määrä).

Total Bolus (U) Pumpun tallentama lisäinsuliinin kokonaismäärä,
joka on annosteltu kyseisenä vuorokautena.

Basal  % Osoittaa perusinsuliinin osuuden kokonaisinsuliinista
(prosentteina ja kokonaislukuina).

Bolus % Osoittaa lisäinsuliinin osuuden kokonaisinsuliinista
(prosentteina ja kokonaislukuina).

№ of Boluses Lisäannostapahtumien määrä kyseisenä
vuorokautena.

Bolus Wizard Events Bolus Wizard -tapahtumien kokonaismäärä kyseisenä
vuorokautena.

Bolus Wizard Overrides Bolus Wizard -tapahtumat, joissa annosteltu
insuliinimäärä oli eri  kuin suositeltu määrä.

№ of Meal Boluses
Kyseiseltä vuorokaudelta tallennetut Bolus Wizard
−tapahtumat, joissa tallennettu hiilihydraattimäärä
oli suurempi kuin nolla.
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Sarakkeen nimi Kuvaus

№ of Correction Boluses
Kyseiseltä vuorokaudelta tallennetut Bolus Wizard
−tapahtumat, joissa tallennettu
korjauslisäannosmäärä oli suurempi kuin nolla.

№ of Manual Boluses
Kyseiseltä vuorokaudelta tallennetut
lisäannostapahtumat, jotka eivät olleet Bolus Wizard -
tapahtumia.

Sarakkeiden järjestyksen muuttaminen

Voit muuttaa tietotaulukon sarakkeiden järjestystä valitsemalla siirrettävän sarakkeen ja

napsauttamalla ylä- ja alanuolipainikkeita .  (Ylin ja alin nuolipainike siirtävät

tietosarakkeen koko luettelon alkuun tai loppuun.)

HUOMAUTUS: Column Order -luettelon ylimmät tiedot näkyvät tietotaulukon

ensimmäisessä sarakkeessa. Alimmat tiedot näkyvät tietotaulukon viimeisessä

sarakkeessa.

Raporttien luontiasetusten hyväksyminen

Kun Column Order -luettelo sisältää kaikki haluamasi tiedot oikeassa järjestyksessä, napsauta

OK-painiketta.

Tietotaulukko sisältää nyt valitsemasi tiedot valitsemassasi sarakejärjestyksessä.
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3

Profile-työtila

Profiili  muistuttaa potilaskertomuksen kansilehteä. Se sisältää potilastiedot, kuten nimen ja

syntymäajan. Potilaalle on luotava profiili,  ennen kuin laitetietoja voidaan kerätä ja käyttää

hoitoraporteissa.

Profile-työtilassa voit myös luoda yhteyden potilaan CareLink Personal -tiliin. Kun yhteys on

luotu, voit hakea potilaan laitetiedot CareLink Personal -tilistä milloin tahansa ilman, että

potilaan tarvitsee tulla vastaanotolle.

Ennen kuin aloitat

Voit tarvittaessa mukauttaa potilasprofiilit niin, että ne sisältävät vain tiedot, joita haluat

kerätä. Lisätietoja on kohdassa Potilasprofiilin asetukset sivulla 13.

Lisäksi tarvitset käyttäjänimen ja salasanan, jos haluat luoda yhteyden potilaan CareLink

Personal -tiliin. Potilaan on oltava läsnä, kun määrität yhteystiedot.
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Uusien profiilien lisääminen

Aina kun lisäät potilaan CareLink Pro -järjestelmään, sinun on ensin täytettävä potilaalle

profiili.

1 Valitse File > New Patient tai napsauta Add Patient -painiketta .

Näyttöön tulee Profile-työtila.

HUOMAUTUS: Jos haluat lisätä tai muuttaa potilasprofiilin kenttiä, napsauta

customize fields -linkkiä. Katso kohta Potilasprofiilin asetukset sivulla 13.

2 Täytä Patient Profile -osion kentät.

3 Napsauta SAVE-painiketta.

Uusi potilasprofiili lisätään CareLink Pro -tietokantaan. Näyttöön tulee viesti, joka vahvistaa

profiilin tallennuksen.

Pakollisten kenttien täyttäminen

1 Jos et ole täyttänyt pakollista kenttää, kun tallennat potilasprofiilin, kentän viereen tulee

viesti. Et voi tallentaa profiilia, ennen kuin kenttä on täytetty.

2 Täytä kenttä.

3 Napsauta SAVE-painiketta.

4 Kun näyttöön tulee vahvistusviesti, napsauta OK-painiketta.

Potilasprofiilien muokkaaminen

1 Varmista, että potilaan Profile-työtila on avoinna.

2 Napsauta EDIT-painiketta.

3 Muokkaa haluamiasi tietoja Patient Profile -osiossa.

4 Napsauta SAVE-painiketta.

Näyttöön tulee viesti, joka vahvistaa profiilin tallennuksen.

Potilastietojen poistaminen järjestelmästä

1 Varmista, että potilaan Profile-työtila on avoinna.

2 Tarkista, että olet poistamassa oikean potilaan. Potilasprofiilin poistaminen poistaa myös

kaikki potilaan tiedot CareLink Pro -tietokannasta, eikä poistoa voi peruuttaa.

3 Napsauta >> delete patient record -linkkiä, joka on profiilin synkronointiosion yläpuolella.

Näyttöön tulee viesti, joka varoittaa siitä, että potilastietueen poistaminen poistaa kaikki

potilastiedot.
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4 Poista potilastietue napsauttamalla Yes-painiketta.

Yhteyden luominen CareLink Personal -tiliin

Voit luoda yhteyden potilaan CareLink Personal -tiliin, jos potilas antaa siihen luvan. Potilaat

voivat ladata ja tallentaa laitteesta saadut tiedot tähän www-pohjaiseen työkaluun ja luoda

erilaisia hoitoraportteja.

Kun olet luonut yhteyden potilaan CareLink Personal -tiliin, voit hakea omalle koneellesi

potilaan tallentamat laitetiedot. Toiminto sopii erinomaisesti CareLink Pro -hoitoraporttien

luomiseen vastaanottokäyntien välillä. Se myös vähentää tarvetta lukea potilaan laitteen

tiedot vastaanotolla.

Jos potilaalla ei ole vielä CareLink Personal -tiliä, voit  kehottaa häntä luomaan tilin

lähettämällä sähköpostikutsun.

Yhteyden luominen olemassa olevaan tiliin

HUOMAUTUS: Potilaan pitää olla läsnä näiden vaiheiden aikana.

1 Varmista, että Internet-yhteys on auki.

2 Avaa potilaan Profile-työtila.

3 Varmista, että kaikki Patient Profile -osion pakolliset kentät on täytetty.

4 Napsauta LINK TO EXISTING ACCOUNT  -painiketta.

Näkyviin tulee CareLink Personal -järjestelmän Log In -sivu.

5 Anna potilaan tehdä seuraavat toimet:

a. Kirjoita käyttäjänimi ja salasana.

b. Napsauta Sign In -painiketta.

Näkyviin tulee Anna käyttöoikeus  -sivu, joka perustuu potilaan ilmoittautumisen yhteydessä

antamiin kieli- ja alueasetuksiin.

6 Anna potilaan tehdä seuraavat toimet:

a. Lue käyttöehdot.

b. Valitse Hyväksyn yllä olevat käyttöehdot...  -valintaruutu.

c. Napsauta Anna käyttöoikeus  -painiketta.

d. Pyydä potilasta ilmoittamaan, kun näytössä näkyy Kiitos  -sivu.

7 Voit tarvittaessa tulostaa käyttöehdot potilaalle napsauttamalla Tulosta-painiketta. Sinulla on

nyt yhteys potilaan CareLink Personal -tiliin.

Sähköpostikutsun lähettäminen

Voit kehottaa potilasta luomaan CareLink Personal -tilin lähettämällä hänelle sähköpostikutsun

seuraavasti:

1 Avaa potilaan Profile-työtila.
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2 Varmista, että kaikki Patient Profile -osion pakolliset kentät on täytetty.

3 Napsauta SEND E-MAIL INVITATION TO PATIENT -painiketta.

4 Varmista, että Patient Name-, E-Mail Address- ja Language-kentät on täytetty oikein.

5 Napsauta SEND-painiketta.

Potilasprofiilin tila-alueella näkyy vahvistus sähköpostin lähettämisestä.

Tietojen hakeminen yhdistetystä tilistä

Jos sinulla on yhteys potilaan CareLink Personal -tiliin, CareLink Pro -ohjelmisto hakee tilin

mahdolliset uudet tiedot automaattisesti  joka kerta, kun avaat potilaan potilasprofiilin.

HUOMAUTUS: Voit varmistaa tietojen automaattisen haun valitsemalla Tools > Options >

General ja varmistamalla, että Synchronize with CareLink Personal -valintaruutu on

valittuna.

Voit hakea potilaan CareLink Personal -tilin tiedot milloin tahansa potilasprofiilin avaamisen

jälkeen seuraavasti:

1 Varmista, että potilaan Profile-työtila on avoinna ja että Internet-yhteys on auki.

2 Valitse Tools > Synchronize Patient Data.

Potilasvälilehden synkronointikuvake  pyörii. Kun kuvake pysähtyy, tietojen haku on

päättynyt.

HUOMAUTUS: Jos potilas ei enää halua jakaa CareLink Personal -tietojaan, näyttöön

tulee tästä viesti.

3 Kaikki CareLink Personal -tilistä haetut uudet tiedot näkyvät potilaan raporteissa.
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Potilaan CareLink Personal -tilin ja CareLink Pro -ohjelmiston yhteyden
poistaminen

Voit poistaa potilaan CareLink Personal -tilin ja CareLink Pro -ohjelmiston yhteyden. Tämä

vaihtoehto on käytettävissä vain silloin, kun potilaan tiliin on luotu yhteys. Kun yhteys

poistetaan, CareLink Pro -ohjelmisto ei voi enää hakea tietoja potilaan CareLink Personal -tilistä.

Se ei vaikuta siihen, miten potilas itse käyttää CareLink Personal -tiliään.

1 Avaa potilastietue ja avaa Profile-työtila.

2 Napsauta UNLINK ACCOUNT -painiketta.

3 Valitse vahvistusviestistä Yes. Potilaan henkilökohtainen profiili  ei ole enää yhteydessä

CareLink Pro -ohjelmistoon.

Tilaksi vaihtuu Not linked,  ja näytössä näkyvät LINK TO EXISTING ACCOUNT- ja SEND E-

MAIL INVITATION TO PATIENT  -painikkeet.
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4

Laitteiston kokoonpano

Jos haluat lukea tiedot laitteesta suoraan, käytössäsi on oltava potilaan laitteen lisäksi

tarvittavat kaapelit  tai tiedonsiirtolaitteet.

Vaihtoehtoisesti voit hakea tiedot luomalla yhteyden potilaan CareLink Personal -tiliin, jos

potilas on ladannut laitetiedot tiliin. Ohjeet yhteyden luomiseen potilaan CareLink Personal

−tiliin ovat kohdassa Yhteyden luominen CareLink Personal -tiliin sivulla 21.

Laitteiden kytkeminen

Katso yleiskuvasta, miten laitteet kytketään tietokoneeseen tiedonsiirtoa varten. Jäljempänä

olevissa kaavioissa on kuvattu laitekohtaisia tiedonsiirtokytkentöjä.

Saat lisätietoja kytkennöistä noudattamalla CareLink Pro -näyttöjen ohjeita laitetietojen luvun

aikana.
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Laitteiston kokoonpanon yleiskuva

Seuraavassa esimerkissä käytetään CareLink-USB-laitetta pumpun ja tietokoneen väliseen

tiedonsiirtoon.

Esimerkkejä sarja- ja USB-kaapelin kytkennöistä:
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Valinnainen ComLink, jota käytetään Paradigm-sarjan pumppujen kanssa:

Valinnainen Com-Station, jota käytetään Medtronic MiniMed 508 -pumpun kanssa:
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Devices-työtila

Potilaan laitteen tietojen lukemiseen tarvittavat tiedot, kuten merkki,  malli ja sarjanumero,

tallennetaan Devices-työtilaan. Näin sinun ei  tarvitse syöttää tietoja joka kerta, kun luet

laitetiedot.

Devices-työtilan laitteet tallennetaan kahteen luetteloon – Active Devices- tai Inactive Devices

-luetteloon. Kun lisäät laitteen, se tallentuu automaattisesti Active Devices -luetteloon. Voit

lukea tiedot ainoastaan Active Devices -luettelossa näkyvistä laitteista. Ne ovat laitteita, joita

potilas todennäköisesti käyttää tällä hetkellä.

Muut potilaan laitteet, joita potilas ei käytä tällä hetkellä,  voidaan tallentaa Inactive Devices

−luetteloon. Näin tiedot pysyvät tallessa. Nämä laitteet voidaan muuttaa aktiivisiksi milloin

tahansa.
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Ennen kuin aloitat

Ennen kuin voit avata potilaan Devices-työtilan, potilaan profiilin on oltava tallennettuna

järjestelmään. Katso kohta Uusien profiilien lisääminen sivulla 20.

Jotta voit lisätä laitteet tai lukea sen tiedot suoraan, laitteen on oltava yhteydessä

tietokoneeseen. Katso kohdasta Laitteiden kytkeminen sivulla 24,  miten laitteet kytketään

tietokoneeseen tiedonsiirtoa varten.

Laitteen lisääminen

Voit hakea potilaan CareLink Personal -tilistä tiedot laitteesta, jota ei ole vielä lisätty.

Järjestelmä lisää nämä laitteet automaattisesti,  kun se synkronoi tiedot CareLink Personal -tilin

ja CareLink Pro -ohjelmiston välillä.

HUOMAUTUS: Potilasta kohden voi olla vain yksi aktiivinen pumppu. Uuden pumpun
lisääminen siirtää olemassa olevan pumpun epäaktiivisten laitteiden luetteloon.

Medtronic-pumpun tai Guardian-monitorin lisääminen

1 Varmista, että lisättävä laite on yhteydessä tietokoneeseen. (Kytkentävaiheet ovat kohdassa

Laitteiden kytkeminen sivulla 24.)

2 Napsauta potilaan välilehteä tai kaksoisnapsauta potilaan nimeä Patient Lookup -taulukossa.

3 Avaa potilaan Devices-työtila napsauttamalla Devices-painiketta .

4 Napsauta ADD DEVICE  -painiketta.

5 Valitse Medtronic Pump/Guardian.  Näkyviin tulee ohjattu toiminto Add Medtronic Pump /

Guardian.

HUOMAUTUS: Pumppumalli on pumpun takana tai pumpun tilanäytössä.

6 Määritä lisättävä laite valitsemalla vastaava valintanappi.
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Jos valitsit MiniMed 508 pump  -vaihtoehdon, siirry vaiheeseen 9.

7 Napsauta NEXT-painiketta. Näkyviin tulee Serial Number -sivu.

HUOMAUTUS: Näkyviin tulee virheilmoitus, jos et syötä oikeaa sarjanumeroa. Tarkista
tämän sivun esimerkit ja tarkista, että syötät oikeat merkit pumpun takaa. Kirjoita

nämä kuusi merkkiä tarvittaessa uudelleen.

8 Käytä apuna tämän sivun esimerkkejä ja etsi lisättävän laitteen kuusimerkkinen sarjanumero.

(Jos tarvitset apua sarjanumeron löytämisessä, napsauta >> learn more -linkkiä.) Kirjoita

nämä kuusi merkkiä Device Serial Number -kenttään.

9 Napsauta NEXT-painiketta. Näkyviin tulee seuraavankaltainen Communication Options

−sivu.

10 Napsauta avattavaa Choose Port  -valikkoa ja valitse tietokoneen portti, johon ComLink,

Paradigm Link®, CareLink-USB-laite tai Com-Station kytketään. Jos et ole varma oikeasta

portista, valitse Auto Detect (or USB).
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11 Napsauta NEXT-painiketta. Näkyviin tulee seuraavankaltainen Test Connection -sivu.

12 Noudata mahdollisia laitetta koskevia ohjeita ja napsauta TEST-painiketta.

Näyttöön tulee viesti onnistuneesta yhteydestä. Jos yhteys onnistui, siirry seuraavaan

vaiheeseen.

HUOMAUTUS: Tämä testi ei lue pumpun tietoja vaan tarkistaa toimivan yhteyden

pumpun ja tietokoneen välillä.

Jos yhteys epäonnistui, varmista, että laitteen ja tietokoneen välissä oleva laitteisto on

kytketty oikein. Napsauta myös ohjatun toiminnon sivuilla BACK-painiketta ja varmista, että

syöttämäsi laitetiedot ovat oikein.

13 Napsauta DONE-painiketta.

Mittari lisätään potilaan Active Devices -luetteloon.

Mittarin lisääminen

1 Napsauta potilaan välilehteä tai kaksoisnapsauta potilaan nimeä Patient Lookup -taulukossa.

2 Varmista, että lisättävä mittari on yhteydessä tietokoneeseen. (Kytkentävaiheet ovat kohdassa

Laitteiden kytkeminen sivulla 24.)

3 Avaa potilaan Devices-työtila napsauttamalla Devices-painiketta.

4 Napsauta ADD DEVICE  -painiketta.
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5 Valitse Blood Glucose Meter.  Näkyviin tulee ohjattu toiminto Add Blood Glucose Meter.

6 Valitse oikea mittarimerkki valitsemalla vastaava valintanappi.

7 Napsauta NEXT-painiketta. Näkyviin tulee Meter Model -sivu (tämä sivu on erilainen mittarin

valmistajan mukaan).

8 Valitse lisättävä mittarimalli napsauttamalla.
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9 Napsauta NEXT-painiketta. Näkyviin tulee Communication Options -sivu.

HUOMAUTUS: Valittavissa ovat vain vaihtoehdot, jotka koskevat lisättävää mittaria.

10 Napsauta avattavaa Choose Port  -valikkoa ja valitse tietokoneen portti, johon ComLink,

Paradigm Link tai CareLink-USB-laite kytketään. Jos et ole varma oikeasta portista, valitse

Auto Detect (or USB).

11 Napsauta NEXT-painiketta. Näkyviin tulee Test Connection -sivu.

12 Noudata mahdollisia mittaria koskevia ohjeita ja napsauta TEST-painiketta.

Näyttöön tulee viesti onnistuneesta yhteydestä. Jos yhteys onnistui, siirry seuraavaan

vaiheeseen.
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Jos yhteys epäonnistui, varmista, että laitteen ja tietokoneen välissä oleva laitteisto on

kytketty oikein. Napsauta myös ohjatun toiminnon BACK-painiketta ja varmista, että olet

syöttänyt oikeat tiedot.

13 Napsauta DONE-painiketta.

Mittari lisätään potilaan Active Devices -luetteloon.

Laitteen aktivoiminen tai aktivoinnin poistaminen

Potilaan laitteita voidaan siirtää Active Devices- ja Inactive Devices -luettelon välillä tarpeen

mukaan. Laitteen on oltava aktiivinen, jotta voit lukea sen tiedot.

Active Devices -luettelossa voi olla niin paljon mittareita kuin haluat mutta vain yksi pumppu.

Varmista, että haluat muuttaa epäaktiiviseksi sillä hetkellä aktiivisen pumpun, ennen kuin

lisäät uuden pumpun.

Laitteen aktivoinnin poistaminen

1 Napsauta potilaan välilehteä tai kaksoisnapsauta potilaan nimeä Patient Lookup -taulukossa.

2 Avaa potilaan Devices-työtila napsauttamalla Devices-painiketta. Laitteet voivat näkyä

luettelossa vastaavalla laitenimellä. Katso kohta Tuetut laitteet sivulla 2.

3 Poista haluamasi laitteen aktivointi napsauttamalla laitteen alla olevaa >> make this device

inactive -linkkiä. Valittu laite siirtyy Inactive Devices  -luetteloon.

Laitteen aktivoiminen uudelleen

1 Napsauta potilaan välilehteä tai kaksoisnapsauta potilaan nimeä Patient Lookup -taulukossa.

2 Napsauta Devices-painiketta. Näkyviin tulee potilaan Devices-työtila.

Laitteet voivat näkyä luettelossa vastaavalla laitenimellä. Katso kohta Tuetut laitteet sivulla 2.

3 Aktivoi haluamasi laite napsauttamalla laitteen alla olevaa >> activate this device -linkkiä.

Valittu laite siirtyy Active Devices  -luetteloon.

Laitteen poistaminen

Voit poistaa laitteen ja sen tiedot Devices-työtilasta ja CareLink Pro -järjestelmästä seuraavasti:

1 Napsauta potilaan välilehteä tai kaksoisnapsauta potilaan nimeä Patient Lookup -taulukossa.

2 Avaa potilaan Devices-työtila napsauttamalla Devices-painiketta.

Laitteet voivat näkyä luettelossa vastaavalla laitenimellä. Katso kohta Tuetut laitteet sivulla 2.

3 Varmista, että laite on Inactive Devices  -luettelossa. Jos se ei ole, napsauta sen alla olevaa

>> Inactivate this device -linkkiä.

4 Poista haluamasi laite napsauttamalla sen alla olevaa >> delete this device -linkkiä.

Näyttöön tulee viesti, joka varoittaa siitä, että laite ja kaikki sen tiedot poistetaan

potilastietueesta.

5 Poista laite napsauttamalla YES-painiketta.
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Laite ja sen tiedot poistuvat Devices-työtilasta ja CareLink Pro -järjestelmästä. Tämän laitteen

tiedot eivät enää ole käytettävissä raporteissa.

Laitetietojen lukeminen

Yksi tapa hakea laitetiedot on luoda yhteys potilaan olemassa olevaan CareLink Personal

−tiliin. (Katso kohta Yhteyden luominen CareLink Personal -tiliin sivulla 21.)  Toinen tapa on lukea

tiedot suoraan laitteesta tämän kohdan ohjeiden mukaisesti.

CareLink Pro -ohjelmisto voi lukea potilaan laitteen tiedot, jos laite on Active Devices

−luettelossa ja yhteydessä tietokoneeseen. Kun olet hakenut tiedot, voit luoda niistä

raportteja, joiden avulla voit arvioida potilaan hoidon hallintaa. Valittavissa olevat raportit on

kuvattu lyhyesti kohdassa Tietoja raporteista sivulla 43.

CareLink Pro voi kerätä insuliinipumpusta seuraavat tiedot:

• pumpun erilaisia asetuksia, kuten varoitustila, piippauksen äänenvoimakkuus ja aikanäyttö

• perusinsuliinin annostellut määrät

• lisäannostapahtumat ja annostellut määrät

• Bolus Wizard -toimintoon syötetyt tiedot

• täyttömäärät

• pysäytysajat

• sensorin glukoosiarvot tietyltä ajanjaksolta pumpuista, joissa on sensoritoiminnot.

Järjestelmä kerää myös esimerkiksi seuraavia tietoja Guardian REAL-Time -järjestelmästä:

• sensorin glukoosiarvot

• sensorin kerroinarvot

• sensorin kalibrointikertoimet

• ateriamerkit

• insuliinipistokset.

Lisäksi järjestelmään voidaan ladata erilaisia verensokerimittariin tallennettuja tietoja laitetta

luettaessa.

VAARA: Peruuta mahdolliset väliaikaiset perusannokset tai aktiiviset lisäannokset tai
annostele ne loppuun ja poista mahdolliset aktiiviset hälytykset. Pumppu pysähtyy luvun

ajaksi.  Kun luku on päättynyt, varmista, että pumpun annostelu jatkuu.

VAROITUS: Älä käytä pumpun kauko-ohjainta pumpun tietojen luvun aikana. Jos pumpun
paristo on melkein tyhjä, pumppu ei lähetä tietoja tietokoneeseen. Vaihda paristo, jos sen

tilailmaisin ilmoittaa heikosta paristosta.

1 Napsauta potilaan välilehteä tai kaksoisnapsauta potilaan nimeä Patient Lookup -taulukossa.

CareLink Pro Käyttöopas   Devices-työtila 34



2 Varmista, että potilaan laite on yhteydessä tietokoneeseen. (Katso kohta Laitteiden

kytkeminen sivulla 24.)

3 Avaa potilaan Devices-työtila napsauttamalla Devices-painiketta.

Laitteet voivat näkyä luettelossa vastaavalla laitenimellä. Katso kohta Tuetut laitteet sivulla 2.

4 Etsi Active Devices  -luettelosta laite, jonka tiedot haluat hakea, ja varmista, että olet valinnut

oikean portin Choose port -valikosta.

Jos haet pumpun tiedot, napsauta avattavaa Amount of Data  -valikkoa ja valitse, kuinka

paljon pumpputietoja haluat hakea CareLink Pro -ohjelmistoon.

5 Napsauta vastaavaa READ DEVICE  -painiketta.

6 Noudata laitekohtaisia ohjeita ja napsauta OK-painiketta.

7 CareLink Pro -näytössä näkyy edistymispalkki, joka osoittaa, paljonko luettavia tietoja on

jäljellä.

Jos napsautat CANCEL-painiketta laitetietojen luvun aikana, näyttöön tulee varoitus siitä, että

toiminnon peruuttaminen voi johtaa siihen mennessä luettujen tietojen häviämiseen.

Käynnistä lataus uudelleen napsauttamalla READ DEVICE  -painiketta.

- Peruuta napsauttamalla YES-painiketta.

- Jatka laitetietojen lukua napsauttamalla NO-painiketta.

Kun järjestelmä on lukenut laitetiedot, näyttöön tulee vahvistusviesti siitä, että laitteen luku

on valmis.

8 Napsauta OK-painiketta.

- Jos luet pumpun tiedot, poista se pysäytystilasta ohjeiden mukaisesti.

Jos CareLink Pro -ohjelmisto ei pysty lukemaan laitetietoja, katso lisäohjeita Vianetsintä-

luvusta.
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Reports-työtila

CareLink Pro -ohjelmistossa on valittavissa erilaisia raportteja, joiden avulla voit parantaa

potilaiden diabeteshoidon hallintaa. Kunkin raportin sisältämät tiedot perustuvat potilaan

laitteista ja CareLink Personal -ohjelmiston tilistä saatuihin tietoihin.

Raportit  voidaan luoda näytössä, lähettää suoraan tulostimeen tai tallentaa TIFF- tai PDF-

tiedostoina, jotka voidaan liittää sähköiseen potilaskertomukseen (Electronic Medical Record,

EMR). Voit luoda erilaisia raporttityyppejä yhdellä toiminnolla.

Raporteissa näkyvät tiedot on saatu potilaan laitteista, CareLink Personal -tilistä tai

molemmista.

HUOMAUTUS: Lisätietoja raportin osioista sekä esimerkkiraportteja on raporttioppaassa.

Voit avata raporttioppaan CareLink Pro -ohjelmistosta valitsemalla Help > View Report
Reference Guide (PDF) ja valitsemalla haluamasi kielen.

Ennen kuin aloitat

Jos haluat raportin tietyltä ajanjaksolta, sinulla on oltava potilaan laitetiedot kyseiseltä

ajanjaksolta. Potilaan laite on ehkä myös kytkettävä tietokoneeseen, jotta saat senhetkiset

tiedot ennen raporttien luomista.
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Tarkista huolellisesti Verify Report Settings  -vaiheen asetukset, ennen kuin luot raportin.

Tässä vaiheessa voit hienosäätää raporttiasetuksia, jotta saat raportteihin haluamasi tiedot.

Raporttien luominen

Seuraavissa kohdissa kuvataan valittavissa olevat raportit ja annetaan ohjeet niiden

luomiseen.

Jos raportointiprosessi on sinulle jo tuttu ja tiedät, mitä raportteja haluat luoda, voit aloittaa

raporttien luomisen suoraan.

Reports-työtilan avaaminen

Napsauta potilaan välilehteä tai napsauta Open Patient  -painiketta  ja kaksoisnapsauta

potilaan nimeä.

Näyttöön tulee Reports-työtila.

HUOMAUTUS: Varmista SYNC DATA -painiketta napsauttamalla, että sinulla on

viimeisimmät laitetiedot potilaan CareLink Personal -tilistä.

Raportointiajanjakson valitseminen

1 Voit muuttaa raportissa tai raporteissa näkyvän ajanjakson pituutta napsauttamalla avattavaa

Duration-valikkoa ja valitsemalla ajanjakson pituuden. (Pisin ajanjakso on 12 viikkoa.)

2 Ajanjakson alkamis- ja päättymispäivät määräytyvät automaattisesti, paitsi jos olet valinnut

custom date range  -vaihtoehdon.

HUOMAUTUS: Jos valitset sallittua pitemmän ajanjakson, näyttöön tulee

virheilmoitus. Muuta tällöin kestoa tai päivämääriä.

Jos haluat mukauttaa ajanjaksoa, napsauta avattavia From- tai Through-valikkoja ja valitse

haluamasi kuukausi, päivä tai vuosi.

Tietokalenteri

Reports-työtilan tietokalenterialueella näkyy kolmen kuukauden raportointitietojen ikkuna.
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Siniset palkit kuvaavat laitetietoja. Oranssi palkki  kuvaa valitsemaasi raportointiajanjaksoa. Jos

laitetiedot ja raportointiajanjakso ovat päällekkäisiä,  tietoja on osalta näytössä näkyvää

raportointiajanjaksoa tai koko raportointiajanjaksolta.

Tietokalenterialueella näkyy aluksi kolme viimeksi kulunutta kuukautta. Saat näyttöön muut

kuukaudet napsauttamalla kuukausijanan molemmissa päissä olevia nuolipainikkeita .

Raportteihin sisältyvien lähdetietojen valitseminen

1 Jos potilas käyttää pumppuun linkitettyä verensokerimittaria, valitse jokin seuraavista

mittarin verensokeritietojen raportointivaihtoehdoista:

- In the pump: Tämän vaihtoehdon etuna on se, että sinun tarvitsee lukea tiedot vain

potilaan pumpusta. Verensokeriarvoissa on pumpun antama aikaleima, ja ne liittyvät

suoraan käytettyihin Bolus Wizard -laskelmiin. Vaihtoehdon haittana on se, että jos

pumpun ja linkitetyn mittarin välillä on tiedonsiirtohäiriöitä, kyseisen ajan

verensokeriarvot eivät välttämättä näy raportissa. Jos käytössä on jokin MiniMed

Paradigm -pumpun aiempi versio kuin 522/722, raporteissa ei näy myöskään

verensokeriarvoja, joita käytettiin Bolus Wizard -laskelmissa mutta joiden perusteella ei

ryhdytty toimenpiteisiin.

- In the link meter(s):  Tämän vaihtoehdon etuna on se, että raporteissa näkyvät kaikki

linkitettyyn mittariin tallennetut arvot. Vaihtoehdon haittana on se, että jos haluat

korreloida mittarin tiedot pumpun tietojen kanssa, sinun on varmistettava, että pumpun

ja mittarin kellonajat oli synkronoitu. Sinun on myös luettava tiedot pumpusta ja

linkitetystä mittarista erikseen.

2 Voit lisätä laitetiedot raportteihin valitsemalla haluamasi laitteen vieressä olevan

valintaruudun.

Et voi lisätä laitteita, joiden valinnan poistit vaiheessa 1. Voit tarvittaessa valita toisen

linkitettyä mittaria koskevan vaihtoehdon.

3 Voit poistaa laitetiedot raporteista poistamalla haluamasi laitteen vieressä olevan

valintaruudun valinnan.

Et voi poistaa valintaa laitteilta, jotka valitsit vaiheessa 1. Voit tarvittaessa valita toisen

linkitettyä mittaria koskevan vaihtoehdon.

Laitetietojen saatavuuden tarkistaminen

1 Tarkista Reports-työtilan tietokalenterista, onko raportointiajanjaksoa kuvaava oranssi palkki

päällekkäin laitetietoja kuvaavan sinisen palkin kanssa.
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2 Jos palkit ovat päällekkäisiä koko raportointiajanjaksolta, raporttia tai raportteja varten on

tietoja. Napsauta NEXT-painiketta ja siirry kohtaan Raporttiasetusten tarkistaminen sivulla 40.

3 Jos palkit eivät ole päällekkäisiä tai jos ne eivät ole päällekkäisiä riittävältä ajalta, voit

- muuttaa raportointiajanjaksoa

- hakea ylimääräisiä laitetietoja.

Ylimääräisten laitetietojen hakeminen

1 Voit hakea lisää tietoja haluamastasi laitteesta napsauttamalla laitteen READ DEVICE
−painiketta.

Näytössä näkyy laitteen luvun edistymispalkki.

VAARA: Peruuta mahdolliset väliaikaiset perusannokset tai aktiiviset lisäannokset tai
annostele ne loppuun ja poista mahdolliset aktiiviset hälytykset.  Pumppu pysähtyy

luvun ajaksi.  Kun luku on päättynyt, varmista, että pumpun annostelu jatkuu.

VAROITUS: Älä käytä pumpun kauko-ohjainta pumpun tietojen luvun aikana. Jos

pumpun paristo on vajaa, pumppu ei lähetä tietoja tietokoneeseen. Vaihda paristo,

jos laitteen tilanäyttö ilmoittaa vajaasta paristosta.

2 Tarkista, että avattavasta Choose port  -valikosta on valittu laitteelle oikea vaihtoehto.

Voit muuttaa asetusta napsauttamalla avattavaa valikkoa ja valitsemalla eri asetuksen.

3 Varmista, että laite on kytkettynä tietokoneeseen.

4 Jos laite on pumppu, voit määrittää, kuinka paljon tietoja haluat hakea siitä. Napsauta

avattavaa Amount of Data  -valikkoa ja valitse määrä.

HUOMAUTUS: Jos valitset vaihtoehdon All available data,  järjestelmä lukee pumpusta
kaikki tiedot. Nämä tiedot korvaavat järjestelmässä mahdolliset olevat identtiset

tiedot.

5 Napsauta READ DEVICE  -painiketta. Lue huolellisesti näyttöön tuleva viesti, sillä se sisältää

tarkkoja pumpun lukua koskevia ohjeita.

6 Noudata ohjeita ja napsauta OK-painiketta.

Näytössä näkyy laitteen luvun edistymispalkki.

Voit peruuttaa luvun milloin tahansa napsauttamalla CANCEL-painiketta.
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Näyttöön tulee vahvistusviesti luvun päättymisestä.

7 Napsauta OK-painiketta.

Laitteen tiedot näkyvät nyt tietokalenterissa.

8 Napsauta Reports-työtilan yläreunassa olevaa NEXT-painiketta.

Näyttöön tulee Verify Report Settings -vaihe. Tässä näytössä voit varmistaa, että potilaalle

valitut asetukset ovat oikein, ennen kuin luot raportin tai raportit.

Raporttiasetusten tarkistaminen

1 Varmista, että Glucose Target  -asetukset ovat oikein. Kirjoita arvot tai suurenna tai pienennä

arvoja napsauttamalla avattavien Low- ja High-valikoiden ylä- tai alanuolipainikkeita.

HUOMAUTUS: Wake-up- ja Bedtime-aikajanoilla näkyy mittariarvomerkkejä (||  |),

samoin ateriamerkkien aikajanoilla. Koska jotkin raportit perustuvat määrättyjen

ateria-ajanjaksojen, heräämis- tai nukkumaanmenoajanjaksojen tuntien tietoihin, on
tärkeää, että potilaan Bolus Wizard -tapahtumamerkit ja mittariarvomerkit

ryhmitellään vastaavasti.

2 Voit lisätä uuden ateria-ajanjakson napsauttamalla ADD MEAL  -painiketta. Voit muokata

olemassa olevaa ateria-ajanjaksoa napsauttamalla mitä tahansa ateria-ajanjakson kohtaa

aikajanalla.

Aikajanan alapuolella oleva ateria-ajanjakson editori aktivoituu.

HUOMAUTUS: Voit määrittää enintään viisi ateria-ajanjaksoa. Oletusateriat ovat

aamiainen, lounas ja päivällinen.

3 Kirjoita haluamasi asetukset tai valitse ne nuolipainikkeilla.

Jos haluat käyttää näitä asetuksia vain kyseiselle ateria-ajanjaksolle, poista valintaruudun Use

these parameters for all of this patient's meals  valinta.

- Meal Name:  Nimi, jonka haluat antaa ateria-ajanjaksolle.

- Meal Time Period: Tunnit, joiden välillä ateria nautitaan.

- Pre-Meal BG Target (mg/dL tai mmol/L):  Potilaan verensokerin tavoitealueen ala- ja

yläraja ennen ateriaa.

- Pre-Meal Analysis Period:  Ajanjakso, jolta verensokeri analysoidaan ennen aterian

alkua. Tänä aikana mitattuja verensokeriarvoja käytetään yksityiskohtaisessa

raporttianalyysissa.

- Post-Meal BG Target (mg/dL tai mmol/L):  Potilaan verensokerin tavoitealueen ala- ja

yläraja aterian jälkeen.

- Post-Meal Analysis Period:  Ajanjakso, jolta verensokeri analysoidaan aterian jälkeen.

Tänä aikana mitattuja verensokeriarvoja käytetään yksityiskohtaisessa raporttianalyysissa.
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Voit muuttaa olemassa olevan ateria-ajanjakson tai heräämis- ja

nukkumaanmenoajanjakson pituutta napsauttamalla aloitus- tai lopetusviivoja ja

vetämällä niitä aikajanalla.

HUOMAUTUS: Ateria-ajanjaksot eivät voi olla päällekkäisiä, mutta aloitus- ja

lopetusajat voivat olla samat. Ateria-ajanjakson pituuden on oltava vähintään
60 minuuttia.

4 Voit käyttää tämän aterian asetuksia kaikille potilaan aterioille valitsemalla valintaruudun Use

these parameters for all of this patient’s meals.

5 Kun olet lopettanut ateria-ajanjakson luomisen tai muokkaamisen, napsauta SAVE-painiketta.

6 Voit poistaa ateria-ajanjakson napsauttamalla DELETE MEAL  -painiketta. Napsauta DELETE-

painiketta, kun näyttöön tulee vahvistuspyyntö.

7 CareLink Pro -ohjelmisto voi tallentaa nämä asetukset potilaalle seuraavaa raportointikertaa

varten. Voit tallentaa asetukset potilaalle napsauttamalla SAVE SETTINGS  -painiketta.

8 Napsauta Reports-työtilan yläreunassa olevaa NEXT-painiketta.

Tämä on luontitoiminnon Select and Generate Reports -vaihe. Se sisältää

raporttityyppiluettelon ja tietotaulukon, jonka avulla voit lisätä Daily Detail -raporttiin

tiettyjen päivien tiedot tai poistaa tiettyjä päiviä.
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HUOMAUTUS: Voit mukauttaa tietotaulukkonäyttöä napsauttamalla >> customize

columns -linkkiä. Katso kohta Raporttien luontiasetukset sivulla 16.

9 Voit tulostaa näytön tiedot napsauttamalla PRINT-kuvaketta .

Raporttityyppien ja -päivämäärien valitseminen

1 Valitse luotavaan raporttiryhmään haluamasi raportit valitsemalla niiden valintaruudut.

2 Jos olet lukenut tiedot pumpusta tai Guardian-monitorista useammin kuin kerran

raportointiajanjakson aikana, Device Settings Snapshot -raportteja voi olla useita:

a. Varmista, että Device Settings Snapshot -valintaruutu on valittuna.

b. Napsauta avattavan valikon nuolipainiketta ja valitse laiteasetusraportin päivämäärä ja

kellonaika.

- Pumps:  Valitse potilaan pumpun laiteasetusraportti.

- Guardian:  Valitse potilaan Guardian-monitorin laiteasetusraportti.

Jos molemmat kentät on himmennetty, kyseiseltä raportointiajanjaksolta ei ole

laiteasetusraportteja.

3 Katso käytettävissä olevat Daily Detail -raporttitiedot selaamalla tietotaulukkoa.

- Voit lajitella jokaisen sarakkeen tiedot. Lajittele tiedot nousevaan järjestykseen

napsauttamalla sarakkeen otsikkoa. Lajittele tiedot laskevaan järjestykseen

napsauttamalla sarakkeen otsikkoa uudelleen.

HUOMAUTUS: Jos tietyltä päivältä ei ole tietoja, kyseinen päivä ei ole valittavissa.

4 Valitse tietotaulukosta niiden päivämäärien valintaruudut, joilta haluat Daily Detail -raportin.

- Voit lisätä tai poistaa kaikki Daily Detail -raportin päivämäärät yhdellä napsautuksella

valitsemalla tietotaulukon valintaruutusarakkeen ylimmän valintaruudun tai poistamalla

sen valinnan.

Raporttien luominen

1 Kun olet tarkistanut raporttivalinnat, napsauta Reports-työtilan yläosassa olevaa GENERATE

REPORTS -painiketta.

Näyttöön tulee vaihtoehtoluettelo.

2 Valitse haluamasi vaihtoehto: raportin/raporttien esikatselu, tulostus tai tallennus.

Jos valitset Preview-vaihtoehdon, näyttöön tulee Preview-ikkuna.

3 Selaa monisivuisia raportteja napsauttamalla nuolipainikkeita.

4 Tallenna tai tulosta raportti tai raportit napsauttamalla Preview-ikkunan yläreunan vastaavia

painikkeita.
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5 Voit sulkea ikkunan napsauttamalla sen oikeassa yläkulmassa olevaa Close-painiketta .

Tietoja raporteista

Tässä kohdassa kuvataan kukin raporttityyppi.  Lisätietoja raportin osioista sekä

esimerkkiraportteja on raporttioppaassa. Voit avata raporttioppaan CareLink Pro

−ohjelmistosta seuraavasti:

1 Valitse Help > View Report Reference Guide (PDF).

2 Valitse raporttioppaan kieli.

CareLink Pro -raporteilla on seuraavat yleiset ominaisuudet:

• Raportin otsikko  − Raportin otsikko sisältää tunnistetietoja, kuten raportin nimen, potilaan

nimen ja tietolähteen.

• Hiilihydraatit ja verensokeriarvot  − Hiilihydraattiyksiköt näkyvät käyrissä ja kaavioissa

kursivoituina ja verensokeriarvot lihavoituina.

• Viikonlopun tiedot − Viikonlopun päivät näkyvät lihavoituina, jotta ne erottuvat helposti.

• Symbolien selitykset − Symbolien selitykset näkyvät kunkin raportin alareunassa. Joitakin

symboleita käytetään useissa raporteissa, mutta jotkin symbolit ovat raporttikohtaisia.

Adherence-raportti

Adherence-raportti sisältää tietoja, jotka kuvaavat insuliinipumppujen ja sensoreiden käyttöä

ja potilaan omahoitoa. Se vastaa seuraavin kysymyksiin: ”Oliko käytettävissä riittävästi tietoja,

jotta saan tarkan kuvan siitä,  miten potilas käyttää insuliinipumppua ja sensoria (jos käytössä)?

Noudattavatko potilaat annettuja hoito-ohjeita?” Raportti  osoittaa myös, onko sinun

keskusteltava potilaan kanssa diabeteksen omahoidosta.

Sensor & Meter Overview -raportti

Sensor & Meter Overview -raportti on graafinen esitys potilaan vuorokausikohtaisista

sensoriarvoista ja mittarin verensokeriarvoista ja keskiarvoista. Lisäksi se sisältää

tuntikohtaiset arvot 24 tunnin ajalta ja niiden suhteen aterioihin ja nukkumisrytmiin. Raportti

sisältää myös potilaan sensorin glukoosiarvojen ja insuliinin käytön tilastotiedot.

Jos sensoritietoja on käytettävissä, raportin ensimmäisellä sivulla on samankaltainen

sensoritietojen analyysi.  Jos sensoritietoja ei ole käytettävissä, ensimmäisellä sivulla on

mittariarvojen analyysi.

Raportin viimeisellä sivulla tai viimeisillä sivuilla on vuorokausikohtaiset potilaan glykemian,

hiilihydraattien ja insuliinin hallintaa kuvaavat arvot. Kukin sivu näyttää, miten hallinta

vaihtelee raportointiajanjakson kunkin vuorokauden aikana. Yhdellä sivulla näkyvät enintään

14 vuorokauden tiedot.
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Logbook-raportti

Logbook-raportti sisältää mittarin verensokeritiedot sekä hiilihydraatti- ja insuliinitiedot

raportointiajanjakson jokaiselta vuorokaudelta. Raportti sisältää tuntikohtaisen

tapahtumalokin sekä vuorokausikohtaiset keskiarvot ja kokonaismäärät.  Kukin sivu sisältää

enintään 14 vuorokautta. Jos raportointiajanjakso on yli 14 vuorokautta, raportissa on

lisäsivuja.

Device Settings Snapshot -raportti

Device Settings Snapshot -raportti sisältää potilaan pumpun tai Guardian REAL-Time

−monitorin laiteasetukset tiettynä päivänä ja kellonaikana. Voit käyttää raporttia apuna

muiden raporttien tulkinnassa tai potilaan laiteasetusten dokumentointiin.

Pumpun tai monitorin asetukset tallentuvat vain, kun laitetiedot luetaan. Jos laitetta ei luettu

raportointiajanjakson aikana, asetuksia ei  ole käytettävissä.

Daily Detail -raportti

Daily Detail -raportti sisältää glukoositiedot, hiilihydraattimäärät ja potilaan insuliinin käytön

valitulta vuorokaudelta. Järjestelmä luo erillisen raportin jokaiselle vuorokaudelle, jonka

valitset tietotaulukosta.

Daily Detail -raportti sisältää yksityiskohtaiset tiedot valitsemaltasi  vuorokaudelta. Sen avulla

voit keskittyä tiettyyn vuorokauteen, jos potilaan hoidossa tapahtui jotain mielenkiintoista sen

aikana.

Tietojen vieminen

Voit tallentaa CareLink Pro -ohjelmiston keräämät ja tallentamat laitetiedot vientitiedostoon.

Näin voit käyttää potilaan kaikkia laitetietoja tilastointiin tai  erityisten raporttien tai

kaavioiden luontiin. Voit tuoda .csv-tiedoston Microsoft Exceliin tai tiettyihin kliinisiin

tilastointiohjelmiin, joissa voit muokata tietoja lisää.

CSV-tiedosto sisältää tietoja laitteen toiminnoista. Se luetteloi esimerkiksi  mittariarvojen

tallennuksen, pumpun vastaanottamat mittariarvot tai  perusannoksen muutoksen.

HUOMAUTUS: Tämä on edistyneiden käyttäjien toiminto, joka edellyttää laitteen
raakatietojen tuntemista. Sinun on myös osattava käyttää ohjelmistoa, johon tuot .csv-

tiedoston.

Käytä CareLink Pro -vientitoimintoa seuraavasti:

1 Napsauta potilaan välilehteä tai napsauta Open Patient  -painiketta  ja kaksoisnapsauta

potilaan nimeä.

2 Varmista, että näytössä näkyy Reports-työtila.

3 Määritä raportin päivämäärät ja pituus Duration- tai From/Through-valikoihin.
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Pisin ajanjakso, jonka voit valita, on 12 viikkoa.

4 Napsauta export selected data -linkkiä.

Näyttöön tulee Export Data to CSV File -valintaikkuna.

5 Siirry tietokoneen hakemistoon, johon haluat tallentaa .csv-tiedoston. Jos haluat muuttaa

tiedoston nimeä, kirjoita se File name  -kenttään.

6 Napsauta SAVE-painiketta.

HUOMAUTUS: Lisätietoja CSV-tiedostoissa näkyvistä tiedoista on CSV-tiedot-
liitteessä.

CSV-tiedosto on nyt tallennettu tietokoneeseen valitsemaasi paikkaan. Nyt voit tuoda sen

mihin tahansa ohjelmaan, joka tukee tätä tiedostotyyppiä.
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7

Järjestelmänvalvonta

On tärkeää, että varmuuskopioit  CareLink Pro -tietokannan säännöllisesti.  Tietokantaan

tallentuvat kaikki järjestelmän tiedot, jotka ovat kertyneet potilastietueisiin, kuten

profiilitiedot, laitteista haetut tiedot ja raporttiasetukset.

On myös tärkeää, että käytät uusinta CareLink Pro -versiota. Ohjelmistoon on saatavilla

ajoittain päivitettyjä versioita, joissa voi olla tärkeitä parannuksia. Voit  hakea

ohjelmistopäivitykset manuaalisesti tai  valita automaattisen ilmoituksen saatavilla olevista

päivityksistä.

Ohjelmistopäivitysten asentaminen

CareLink Pro -ohjelmistoa päivitetään ajoittain. Kun näyttöön tulee ilmoitus päivityksestä,

lataa uusin ohjelmistoversio seuraavasti.

HUOMAUTUS: Varmuuskopioi tietokanta, ennen kuin lataat ohjelmistopäivityksen. Katso

kohta Tietokannan varmuuskopioiminen sivulla 47.

1 Varmista, että Internet-yhteys on käytettävissä ja auki tietokoneessa.

2 Näyttöön tulee CareLink Pro Update -viesti, kun CareLink Pro -ohjelmistoon on saatavilla

päivitys. Viesti antaa mahdollisuuden ladata päivityksen.

3 Napsauta DOWNLOAD-painiketta. (Jos napsautat CANCEL-painiketta, päivitysilmoitus

sulkeutuu. Voit ladata päivityksen myöhemmin.)

Näyttöön tulee varoitusviesti, joka kehottaa varmuuskopioimaan tietokannan.

4 Luo tietokannasta varmuuskopio napsauttamalla YES-painiketta (ohjeet ovat kohdassa

Tietokannan varmuuskopioiminen sivulla 47). Napsauta NO-painiketta, jos olet jo

varmuuskopioinut tiedot.

Näyttöön tulee viesti, joka vahvistaa uuden CareLink Pro -version latauksen.
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5 Aloita uusimman CareLink Pro -version käyttö napsauttamalla YES-painiketta, jolloin sovellus

sulkeutuu ja käynnistyy uudelleen. Napsauta NO-painiketta, jos et halua käynnistää CareLink

Pro -ohjelmistoa heti uudelleen.

Automaattisten päivitysilmoitusten poistaminen käytöstä

Jos et halua automaattista ilmoitusta CareLink Pro -päivityksistä, toimi seuraavasti:

1 Valitse Tools  > Options.

2 Napsauta General-välilehteä.

3 Poista Communications-osiossa olevan Automatically check for software updates

−valintaruudun valinta.

Päivitysten saatavuuden tarkistaminen manuaalisesti

Voit tarkistaa CareLink Pro -päivitysten saatavuuden manuaalisesti  milloin tahansa.

HUOMAUTUS: Varmuuskopioi tietokanta, ennen kuin lataat ohjelmistopäivityksen. Katso

kohta Tietokannan varmuuskopioiminen sivulla 47.

1 Varmista, että Internet-yhteys on käytettävissä ja auki tietokoneessa.

2 Valitse Tools > Check for Software Updates.

3 Näyttöön tulee viesti, jos päivityksiä ei ole sillä hetkellä saatavilla. Jos päivitys on saatavilla,

näyttöön tulee CareLink Pro Update -viesti.

4 Toimi kuten kohdassa Ohjelmistopäivitysten asentaminen sivulla 46.

Tietokannan varmuuskopioiminen ja palauttaminen

On hyvä määrittää säännöllinen aikataulu tietokannan varmuuskopiointiin. Näin varmistat,

että varmuuskopiointi tehdään säännöllisesti, ja minimoit tietojen häviämisriskin.

Jos varmuuskopioit tai palautat tietokantaa, järjestelmän näyttöön tulee varoitusviesti, jos

ohjelmistolla on aktiivisia käyttäjiä muilla tietokoneilla.

Tietokannan varmuuskopioiminen

Voit varmuuskopioida senhetkisen tietokannan valitsemaasi paikkaan seuraavasti.

1 Varmista, että kaikki potilastietueet on suljettu.

2 Valitse Tools > Backup Database.

HUOMAUTUS: Voit tallentaa tietokannan varmuuskopiot verkkoasemaan tai

siirrettävään tallennusvälineeseen (kuten DVD- tai CD-levylle tai USB-asemaan).

3 Siirry tietokoneen hakemistoon, johon haluat tallentaa varmuuskopiointitiedoston. Jos haluat

muuttaa varmuuskopiointitiedoston nimeä, kirjoita se File name  -kenttään.
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4 Napsauta Save-painiketta. Näytössä näkyy tietokannan tallentumisen edistymispalkki.

Kun varmuuskopiointi on valmis, näyttöön tulee viesti.

5 Sulje viesti napsauttamalla OK-painiketta.

Tietokannan palauttaminen

Käytössä oleva tietokanta on ehkä korvattava, jos sitä ei  pystytä enää avaamaan tai

käyttämään. Mitä uudempi varmuuskopio on, sitä vähemmän menetät tietoja, jos joudut

korvaamaan tietokannan.

VAROITUS: Kun palautat tietokannan varmuuskopiolla, menetät kaikki nykyisen

tietokannan uudet tiedot, jotka on luotu valitun varmuuskopion tallentamisen jälkeen.

Voit valita nykyisen tietokannan korvaavan varmuuskopion seuraavasti.

1 Varmista, että kaikki potilastietueet on suljettu.

2 Valitse Tools > Restore Database.

3 Valitse varmuuskopiointitiedosto, jolla haluat korvata nykyisen tietokannan (tavallisesti se on

uusin varmuuskopio).

4 Napsauta Open-painiketta. Näyttöön tulee varoitusviesti, joka muistuttaa sinua mahdollisesta

tietojen häviämisestä, jos jatkat tietokannan palauttamista.

5 Jatka napsauttamalla OK-painiketta. Näytössä näkyy tietokannan palauttamisen

edistymispalkki.

Kun tietokanta on palautettu, näyttöön tulee viesti.

6 Sulje viesti napsauttamalla OK-painiketta.

Kun järjestelmä ei ole käytettävissä

Jos yrität käynnistää järjestelmän, kun toinen käyttäjä tekee varmuuskopiointia tai palauttaa

tietoja, saat viestin, että järjestelmä ei ole käytettävissä. Et voit käyttää järjestelmää, ennen

kuin toiminto on valmis.

Toimi jommallakummalla tavalla:

• Odota, kunnes toiminto on valmis ja järjestelmä on jälleen käytettävissä.

• Sulje ikkuna napsauttamalla CANCEL-painiketta ja yritä myöhemmin uudelleen.
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Vianetsintä

Tämän kohdan avulla voit ratkaista ongelmia, jotka voivat esiintyä CareLink Pro -ohjelmiston

käytön aikana. Se sisältää myös ohjeet CareLink Pro -ohjelmiston poistoon, jos se on tarpeen.

Sovelluksen yleiset käyttövirheet

Jos yrität ladata ohjelmistopäivityksen Internetin kautta, näyttöön voi tulla viesti, jonka mukaan

sinulla ei ole riittäviä käyttöoikeuksia. Sinulla on oltava järjestelmänvalvojan käyttöoikeudet,

jotta voit ladata CareLink Pro -ohjelmistopäivityksiä.

1 Sulje CareLink Pro -ohjelmistosovellus ja käynnistä tietokone uudelleen.

2 Pyydä toista käyttäjää, jolla on järjestelmänvalvojan käyttöoikeudet, kirjautumaan

tietokoneeseen.

3 Toimi kuten kohdassa Ohjelmistopäivitysten asentaminen sivulla 46.

Ei tietokantayhteyttä

Jos näyttöön tulee viesti,  jonka mukaan tietokantayhteyttä ei ole, siihen voi olla seuraavia

syitä:

• Tietokanta on siirretty. Tietokannan on oltava samassa paikassa, joka valittiin CareLink Pro

−ohjelmiston asennuksen yhteydessä. Jos tietokanta on siirretty, se on siirrettävä takaisin

asennuksen yhteydessä valittuun paikkaan.

• Tietokone ei ole yhteydessä verkkoasemaan, jossa tietokanta sijaitsee. Jos tietokanta on

verkkoasemassa, verkossa voi olla ajoittain häiriöitä, jotka estävät aseman käytön. Ota yhteys

tietokonetukeen ja pyydä ohjeita, miten saat yhteyden tietokannan sisältävän

verkkoasemaan.
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CareLink Pro -ohjelmiston laitoksen salasana unohtunut

Jos kukaan ei muista laitoksen salasanaa, jolla kirjaudutaan CareLink Pro -ohjelmistoon,

CareLink Pro -ohjelmisto täytyy asentaa uudelleen ja täytyy luoda uusi tietokanta. Kun

ohjelmisto on asennettu uudelleen, aiemmassa tietokannassa olleita potilastietoja ei voi enää

käsitellä. Tallenna uuden asennuksen aikana luotu salasana johonkin paikkaan toimistossa,

jotta uusia tietoja ei  menetetä.

Laitteiden lukuvirheet

Virhe Merkitys

The selected serial port could not be opened. Another
operation might be in progress on that port. Please
wait until the port is  available, or select another port.

Tarkista, että valittu COM-portti ei ole toisen
ohjelman käytössä, tai valitse toinen portti.
Käynnistä käyttämäsi tietokone uudelleen ja yritä
lukea laitetiedot uudelleen. Porttiin kytketyssä
laitteistossa (kuten kaapelissa) tai itse portissa voi
olla vikaa. Kytke laitteisto toiseen porttiin ja yritä
lukea laitetiedot uudelleen ongelman
määrittämiseksi.

Auto Detect could not find the device on any available
port. Please check the cable connection, device battery
& status and try again, or try specifying a serial port.

Tarkista kaapelin ja tietokoneen kytkentä ja
varmista, että laitteen paristo on kunnossa. Jos
näissä ei ole vikaa, yritä määrittää tietokoneen
sarjaportti,  johon kaapeli  on kytketty, Auto Detect
−toiminnon käyttämisen sijasta.

Device not found at selected serial port. Please check
the cable connection, device battery & status and try
again, try selecting a different port, or try to Auto
Detect the device.

Tarkista kaapelin ja tietokoneen kytkentä ja
varmista, että laitteen paristo on kunnossa. Jos
näissä ei ole vikaa, yritä valita tietokoneen eri
sarjaportin numero tai valitse Auto Detect
−vaihtoehto.

Unable to communicate with the device. Please ensure
you’ve attached and selected the correct device, check
the cable connection, device battery and status, and try
again.

Tarkista kaikki laitteen luvulle valitut asetukset,
kuten laitteen nimi, sarjanumero ja kytkentätyyppi.
Varmista myös, että laite, kaapeli ja tietokone on
kytketty oikein. Tarkista, että laitteen paristo on
kunnossa eikä laitteessa ole hälytyksiä. Yritä lukea
laite uudelleen.

Unexpected response...  retrying (n%)
Ohjelmisto luki laitteesta uuden odottamattoman
arvon. Järjestelmä yrittää tiedonsiirtoa, kunnes
peruutat sen tai tiedonsiirto onnistuu.

The link device was found, but the device (<serial #>) is
not responding. Please verify the device’s serial
number, place the device closer to the link device to
minimize signal interference, check device battery and
status.

Tarkista, että olet syöttänyt sarjanumeron oikein.
Jos numero on väärin, syötä oikea sarjanumero. Jos
sarjanumero on oikein, yritä siirtää linkkilaitetta
lähemmäs tiedonsiirtolaitetta. Siirrä linkkilaite ja
tiedonsiirtolaite kauas mahdollisista häiriölähteistä
(kuten muista radiotaajuuslaitteista). Tarkista
laitteen pariston tila, ja jos lataat tietoja
insuliinipumpusta, tarkista pumpun annostelutila.

This pump is delivering a temp basal. Please cancel the
temp basal or wait until it completes, and then try
again.

Pumppu, jonka tietoja yrität lukea, annostelee
parhaillaan väliaikaista perusannosta. Odota,
kunnes väliaikainen perusannos on annosteltu
loppuun tai peruuta väliaikainen perusannos ja lue
sitten pumpun tiedot.

This device has active errors or alarms. Please clear the
alarms and try again.

Pumpussa on aktiivisia hälytyksiä, jotka estävät sen
tietojen luvun. Lue hälytysohjeista, miten hälytys
kuitataan. Kuittaa hälytys ja yritä lukea pumpun
tiedot uudelleen.
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Virhe Merkitys

This pump is delivering a bolus. Please cancel the bolus
or wait until it completes, and then try again.

Pumppu, jonka tietoja yrität lukea, annostelee
parhaillaan lisäannosta. Odota, kunnes lisäannos on
annosteltu loppuun tai  peruuta lisäannos ja lue
sitten pumpun tiedot.

The device returned invalid entries; all data read will be
discarded.

Ota yhteys oman maasi edustajaan (katso kohta
Tuotetuki sivulla 2).

Raporttien luontivirheet

Samalle päivälle syötetyt useat tiedot

Jos samalle päivälle ja kellonajalle on syötetty useita saman laitteen tietoja, järjestelmä pitää

tätä ratkaisemattomana ristiriitana. Tämän laitteen tietoja sisältävissä raporteissa ei näy

päällekkäisiä tietoja.

Voit yrittää muuttaa raportointiajanjaksoa, jotta päällekkäiset tiedot jäävät raportin

ulkopuolelle. Vaihtoehtoisesti voit poistaa laitteen järjestelmästä ja lisätä sen uudelleen, jotta

edelliset arvot poistuvat.

Järjestelmän huomioimatta jättämät tiedot

Jos laitteen kellonaikaa on muutettu niin, että tuloksena on päällekkäisiä tietoja tai  aukkoja

tiedoissa vähintään kolmen tunnin ajalta, järjestelmä ei  sisällytä tätä osuutta raportteihin.

Varmuuskopioimisen ja palauttamisen virheet

Tietokantaa ei voi lukita

Tämä tarkoittaa, että käytät järjestelmää usean käyttäjän ympäristössä ja että muita käyttäjiä

on kirjautuneina järjestelmään. Järjestelmän tietokantaa ei  voi varmuuskopioida, kun muut

käyttäjät käyttävät mahdollisesti toimintoja, jotka voivat vaikuttaa tietokantaan. Kun kaikki

muut käyttäjät sulkevat CareLink Pro -ohjelmiston, voit varmuuskopioida tietokannan.

Tietokannan varmuuskopioiminen tai palauttaminen ei valmistu

Muut käyttäjät eivät voi kirjautua ohjelmistoon eikä varmuuskopiointi tai palautus valmistu.

Ota yhteys oman maasi edustajaan (katso kohta Tuotetuki sivulla 2).

Tietokannan palauttaminen epäonnistuu

Tietokannan varmuuskopiotiedosto, jonka yrität palauttaa, on vioittunut. Yritä palauttaa eri

varmuuskopiotiedosto.

Ohjelmiston poistaminen

Voit tarvittaessa poistaa CareLink Pro -ohjelmiston seuraavasti:

1 Avaa Control Panel Windowsin Start-valikosta.
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2 Valitse Add or Remove Programs.  Näkyviin tulee Windowsin Add or Remove Programs

−valintaikkuna.

3 Selaa luetteloa kohtaan Medtronic CareLink Pro ja napsauta sitä.

4 Napsauta Remove-painiketta. Näyttöön tulee InstallShield Wizard.

5 Napsauta Next-painiketta. Näyttöön tulee viesti, joka kehottaa sinua vahvistamaan, että

haluat poistaa sovelluksen.

6 Napsauta Yes-painiketta. Poisto-ohjelma käynnistyy ja poistaa ohjelman ja kaikki sen

tiedostot tietokoneesta. Kun toiminto on valmis, ohjatun poistotoiminnon ikkunaan tulee

vahvistusviesti ohjelman poistosta.

7 Napsauta Finish-painiketta.
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Kuvaketaulukko

Seuraavassa taulukossa on kuvattu pakkausmerkintöjen ja tuotteen kuvakkeet ja symbolit.

Kuvaus Kuvake

Yksi kappale pakkauksessa (1X)

Mukana CD

Huomio: lue kaikki käyttöohjeissa kuvatut vaarat ja
varotoimet.

Valmistuspäivä (vuosi)

Tuotenumero

Conformité Européenne (eurooppalainen
vaatimustenmukaisuus). Tämä symboli tarkoittaa, että
laite on kaikilta osin lääkinnällisiä laitteita koskevan
direktiivin 93/42/ETY ja radio- ja telepäätelaitteita
koskevan direktiivin 1999/5/EY mukainen.
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CSV-tiedot

CareLink Pro -ohjelmistosta vietävät raporttitiedot tallentuvat .csv-tiedostoksi. Tämä tiedosto

voidaan tuoda taulukkolaskentasovellukseen, kuten Microsoft Exceliin. Seuraavassa taulukossa

on lueteltu ja kuvattu kaikki CSV-tiedoston sarakkeiden sisältämät tiedot.

CSV-tiedosto sisältää potilaan nimen ja potilastunnuksen, raportointiajanjakson ja raporttiin

sisällytettyjen laitteiden tunnistetiedot.

Sarakkeiden tietojen kuvaukset

Sarakkeen otsikko Kuvaus

Index Järjestys, jossa tiedot tallennettiin laitteeseen.

Date Päivämäärä, jolloin tiedot tallennettiin laitteeseen.

Time Kellonaika, jolloin tiedot tallennettiin laitteeseen.

New Device Time Uusi päivämäärä ja kellonaika, jos niitä muutettiin
laitteessa.

BG Reading (mg/dL tai mmol/L)

Mittarin, Guardian-monitorin tai pumpun tallentama
verensokeriarvo. Jos tiedot ovat pumpusta tai
Guardian-monitorista, sarakkeessa näkyvät
manuaalisesti syötetyt verensokeriarvot ja linkitetystä
mittarista saadut verensokeriarvot.

Linked BG Meter ID Sen linkitetyn mittarin sarjanumero, joka lähetti
tietyn verensokeriarvon laitteeseen.

Basal  Rate (U/h) Aktiivinen perusannos eli perusinsuliinin
annostelunopeus yksiköinä tunnissa.

Temp Basal Amount
Jos pumpulla on annosteltu väliaikaisia
perusannoksia, tässä näkyy väliaikaisen
perusannoksen määrä.

Temp Basal Type
Väliaikaisen perusannoksen tyyppi
(insuliiniyksikkömäärä tai prosenttiosuus
perusannoksesta).

Temp Basal Duration (m) Väliaikaisen perusannoksen kesto minuutteina (katso
yllä kuvattu tyyppi).
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Sarakkeen otsikko Kuvaus

Bolus Type

Lisäannoksen tyyppi: normaali lisäannos, jatkettu
lisäannos, yhdistelmälisäannoksen normaali osuus tai
jatkettu osuus [Normal, Square, Dual (normal part)
tai Dual (square part)].

Bolus Volume Selected (U) Valittu insuliiniyksikkömäärä, joka annostellaan
lisäannoksen annostelun aikana.

Bolus Volume Delivered (U) Todellinen insuliiniyksikkömäärä, joka annosteltiin
lisäannoksen annostelun aikana.

Programmed Bolus Duration (h) Jatketun lisäannoksen tai yhdistelmälisäannoksen
jatketun osuuden kesto.

Prime Type

Manuaalinen tai  vakio. Manuaalista täyttöä käytetään
sen jälkeen kun pumppu on palautettu
alkuasentoon. Sillä täytetään infuusiosetin letku
ennen sen kiinnittämistä kehoon. Vakiotäyttöä
käytetään sen jälkeen kun infuusiosetti on kiinnitetty
kehoon. Sillä täytetään pehmeä kanyyli insuliinilla
sisäänvientineulan irrottamisen jälkeen.

Prime Volume Delivered (U) Täytön aikana annosteltu todellinen
insuliiniyksikkömäärä.

Alarm Esiintyneen hälytyksen nimi.

Suspend Ilmaisee, että pumppu on pysähtynyt.

Rewind Päivä ja kellonaika, jolloin laite on palautettu
alkuasentoon.

BWZ Estimate (U) Arvioitu lisäannosmäärä,  joka on laskettu Paradigm-
pumpun Bolus Wizard -toiminnolla.

BWZ Target High BG (mg/dL tai mmol/L) Verensokerin tavoitealueen yläraja, jota Bolus Wizard
-toiminto käyttää.

BWZ Target Low BG (mg/dL tai  mmol/L) Verensokerin tavoitealueen alaraja, jota Bolus Wizard
-toiminto käyttää.

BWZ Carb Ratio

Insuliini-hiilihydraattisuhteen asetus. Jos yksikkönä
käytetään grammoja, suhdeluku osoittaa
hiilihydraattigrammat, jotka yksi insuliiniyksikkö
kattaa. Jos yksikkönä käytetään vaihtoannoksia,
suhdeluku osoittaa insuliiniyksiköt, jotka kattavat
yhden vaihtoannoksen.

BWZ Insulin Sensitivity

Insuliiniherkkyyden asetus. Insuliiniherkkyys osoittaa,
kuinka paljon yksi insuliiniyksikkö laskee
verensokeria. Bolus Wizard -toiminto käyttää tätä
asetusta.

BWZ Carb Input Bolus Wizard -toimintoon syötetty hiilihydraattien
määrä, jota käytetään lisäannoksen arviointiin.

BWZ BG Input (mg/dL tai mmol/L) Bolus Wizard -toimintoon syötetty verensokeriarvo,
jota käytetään lisäannoksen arviointiin.

BWZ Correction Estimate (U)
Bolus Wizard -toiminnon laskema
korjauslisäannoksen insuliiniyksikkömäärä, jolla
korjataan verensokeri.

BWZ Food Estimate (U)
Bolus Wizard -toiminnon laskema aterialisäannoksen
arvioitu insuliiniyksikkömäärä, jolla katetaan arvioitu
nautittava hiilihydraattimäärä.

BWZ Active Insulin (U)
Edellisistä lisäannoksista elimistössä jäljellä oleva
laskettu aktiivisen insuliinin määrä, jota Bolus Wizard
-toiminto käyttää laskiessaan arvioitua lisäannosta.

Sensor Calibration BG (mg/dL tai  mmol/L) Verensokeriarvo (mg/dl tai mmol/l),  jota käytettiin
sensorin kalibrointiin.
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Sarakkeen otsikko Kuvaus

Sensor Glucose (mg/dL tai mmol/L) Sensorin glukoosiarvo.

ISIG value Tulosignaalit  (ISIG), jotka luetaan sensorista ja
mitataan nanoampeereina (nA).

Lisätietoja CareLink Pro -ohjelmistolla tallennetuista CSV-
tiedostoista

CSV-tiedoston yläreunassa oleva otsikko sisältää seuraavat tiedot:

• potilaan nimi

• valittujen laitteiden ja niiden sarjanumeroiden luettelo

• valittu päivämääräalue.

Jokaisella sarakeryhmällä on otsikko, joka sisältää seuraavat tiedot:

• laitteen nimi, jota sarakeryhmä koskee

• laitteen sarjanumero.

Poikkeamat tietojen odotetusta järjestyksestä

CSV-tiedot voivat näkyä muussa kuin odotetussa järjestyksessä useista syistä johtuen.

• Laitteen päivämäärän tai kellonajan muutokset voivat muuttaa tietojen järjestystä tai johtaa

siihen, että tiedostossa näkyy tietoja valitun päivämääräalueen ulkopuolelta.

• Jos laitetietojen lukukertojen välissä on pitkä tauko, kyseisen laitteen tietoja voi näkyä useissa

sarakeryhmissä.
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Sanasto

A1C - Glykosyloitunut hemoglobiini.

A1C-testi - Hemoglobiinin A1C-testi, jolla arvioidaan pitkäaikaista verensokeripitoisuutta.

Askel - Käyttäjän asettama insuliinimäärä, jota käytetään helpon lisäannoksen annostelussa.

Aterialisäannos - Insuliiniannos, joka kattaa aterian jälkeen odotettavasti nousevan verensokerin.

AUC (area under the curve) - Käyrän alle jäävä alue, joka osoittaa korkeiden ja matalien arvojen
vaihteluiden määrän ennalta asetettujen arvojen perusteella. Vaihtelutiedot osoittavat korkean
tai matalan verensokerin yleisyyden. AUC-arvo osoittaa tapahtumien suuruusluokan näyttämällä,
kuinka kaukana arvot olivat tavoitealueesta ja kuinka pitkään.

CareLink® Personal - Online-palvelu, joka mahdollistaa diabeteksen hallinnan Internetin kautta.

ComLink - Radiotaajuinen (RF) lähetin-vastaanotinlaite, jolla ladataan Paradigm-pumpun tiedot
tietokoneeseen.

Com-Station - Laite, jolla ladataan MiniMed 508 -pumpun ja kolmansien osapuolien mittareiden
tiedot tietokoneeseen.

Dual Wave® -lisäannos - Yhdistelmälisäannos, joka koostuu välittömästi annosteltavasta
normaalista lisäannoksesta ja sen perään annosteltavasta jatketusta lisäannoksesta (Square Wave
-lisäannoksesta). Jatketun lisäannoksen osuus annostellaan tasaisesti tietyn ajanjakson kuluessa.

Easy Bolus™ - Helppo lisäannos, normaalin lisäannoksen annostelutapa. Helppo lisäannos
annostellaan pumpun helppo lisäannos -painikkeella.

HbA1c - Glykosyloitunut hemoglobiini.

HbA1c-testi - Hemoglobiinin A1C-testi, jolla arvioidaan verensokeripitoisuuden hallintaa tai
keskiarvoa 2–3 kuukauden ajanjaksolta.

HH - Hiilihydraatti.

Hiilihydraattisuhdeluku - Grammoina ilmoitettu hiilihydraattimäärä, jonka yksi insuliiniyksikkö
kattaa. (Katso myös ”Vaihtoannossuhdeluku”.)

Hiilihydraattiyksiköt - Bolus Wizard -toiminnon käytössä tarvittava ateriatieto. Yksiköksi valitaan
hiilihydraattigrammat tai -vaihtoannokset.

Hyperglykemia - Verensokeriarvojen tarkkailulla havaittu korkea verensokeri, jolla voi olla joitakin
seuraavista oireista: pahoinvointi, oksentelu, näön hämärtyminen, päänsärky, vatsavaivat,
lisääntynyt virtsaamistarve ja virtsan määrä sekä letargia.

Hypoglykemia - Verensokeriarvojen tarkkailulla havaittu matala verensokeri, jolla voi olla joitakin
seuraavista oireista: kova nälkä, tärinä tai vapina, hikoilu, kaksoiskuvat, huimaus, päänsärky,
sammaltava puhe, äkilliset mielialanvaihtelut tai persoonallisuuden muutokset.
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Infuusiosetti - Infuusiovälineet, joilla asetetaan ja kiinnitetään kanyyli ihon alle ja jotka kuljettavat
insuliinin asetuskohtaan pumpusta letkun kautta.

Insuliiniherkkyys - Määrä (mg/dl tai mmol/l), jonka yksi insuliiniyksikkö laskee verensokeria (VS).
(Tämä on Bolus Wizard -toimintoon ohjelmoitu tieto.)

Insuliinipitoisuus - Insuliinin voimakkuus tai tyyppi, jonka lääkäri on määrännyt käyttäjälle. Se
vaikuttaa pumpun insuliinin annostelunopeuteen. Jos käyttäjän insuliinipitoisuus muuttuu,
perusannosmallit, maksimiperusannos ja lisäannokset on ohjelmoitava pumppuun uudelleen.

ISIG - Sensorin ISIG-arvot osoittavat, toimiiko sensoria käyttävän järjestelmän lähettimen
elektroniikka oikein. Jos ISIG-arvo on alle 24,00 nA tai yli 29,00 nA, soita tuotetukeen. Lähetin on
ehkä vaihdettava uuteen.

Jatketun lisäannoksen osuus - Yhdistelmälisäannoksen (Dual Wave -lisäannoksen) toinen osa (Jatk.,
Jtk). Jatketun lisäannoksen osuus annostellaan tasaisesti tietyn ajanjakson kuluessa normaalin
osuuden (Nyt) jälkeen.

Kalibrointimuistutus - Pumppu antaa MITT. VS VIIM. hh:mm -varoituksen automaattisesti 12 tunnin
välein merkiksi siitä, että nykyinen kalibrointiarvo ei ole enää voimassa. Kalibrointimuistutuksessa
näkyy kalibrointiarvon vanhenemiseen jäljellä oleva aika, jolloin käyttäjä haluaa muistutuksen
kalibroinnista. Jos kalibrointimuistutuksen arvoksi on asetettu esimerkiksi 2 tuntia, MITT. VS VIIM.
hh:mm -varoitus esiintyy 2 tuntia ennen vaadittua kalibrointiajankohtaa.

Ketoainetesti - Ketoaine on kuona-aine, jota elimistö tuottaa, kun sen on poltettava rasvaa glukoosin
sijasta tuottaakseen energiaa. Se voi olla merkki elimistön insuliininpuutoksesta. Ketoainetestillä
mitataan veren tai virtsan ketoainepitoisuutta.

Korjauslisäannos - Tarvittava insuliinimäärä, jolla lasketaan korkea verensokeri tavoitealueelle.

Korjauslisäannoskerroin - Arvo, joka osoittaa, kuinka paljon 1,0 yksikköä insuliinia laskee
verensokeria. Kertoimen avulla lasketaan korjauslisäannoksen määrä, kun verensokeri on korkea.
(verensokeriarvo) - (verensokerin tavoitearvo) = X. X ÷ (korjauslisäannoskerroin) =
korjauslisäannoksen määrä.

Korkea glukoosi - Pumppu hälyttää, jos sensori osoittaa, että käyttäjän verensokeri on yhtä suuri tai
suurempi kuin tämä arvo. Voit ottaa tämän toiminnon käyttöön tai poistaa sen käytöstä.

Lataaminen - Pumpun tai mittarin tietojen siirtäminen CareLink® Personal -palvelimeen.

Linkittää, linkki
(1) Linkittäminen tarkoittaa mittaritoiminnon käyttöönottoa ja asetusten määrittämistä, jotta
pumppu voi vastaanottaa verensokeriarvot mittarista.
(2) Järjestelmässä linkki tarkoittaa myös hypertekstilinkkiä. Kun napsautat hypertekstilinkkiä, se
siirtää sinut toiseen kohtaan järjestelmässä tai toiseen www-sivustoon.

Lisäannoksen äänimerkki - Pumppu voidaan ohjelmoida antamaan äänimerkki, kun käyttäjä
valitsee annosteltavan lisäinsuliinin määrän (0,5 tai 1,0 yksikköä). Tämä on hyödyllistä tilanteissa,
kun pumpun painikkeita on vaikea nähdä.

Lisäinsuliini - Insuliiniannos, jonka tarkoitus on kattaa verensokerin odotettavissa oleva nousu
(esimerkiksi aterian tai välipalan jälkeen) tai laskea korkea verensokeri tavoitealueelle.

Lähett. SN - Käytössä olevan lähettimen sarjanumero.

MAD % (mean absolute difference %) - Absoluuttisen eron keskiarvo prosentteina, joka kuvaa,
miten tarkasti sensoriarvo on kalibroitu VS-mittarin arvojen mukaan. Mitä pienempi arvo on, sitä
suurempi on kalibrointitarkkuus. MAD % -arvo saadaan laskemalla ajallisesti lähekkäin olevien
sensorin glukoosiarvojen ja VS-mittarin arvojen muodostamien parien ero, jakamalla se VS-
mittarin arvolla ja laskemalla sitten kaikkien arvoparien keskiarvo.

Maksimilisäannos - Lisäinsuliinin enimmäismäärä, joka pumppu voi annostella kerralla. (Käyttäjä
määrittää asetuksen.)

Maksimiperusannos - Perusinsuliinin enimmäismäärä, joka pumppu voi annostella kerralla.
(Käyttäjä määrittää asetuksen.)

Malli, normaali - Normaali perusannos, joka sopii potilaan tavallisiin päivittäisiin rutiinitoimiin. Kun
mallitoiminto on poissa käytöstä, pumppu käyttää normaalia perusannosmallia.
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Mallitoiminto - Pumpun laajennettu toiminto, jolla voidaan ohjelmoida valinnaisia
perusannosmalleja (malli A ja B). Näillä malleilla voidaan kattaa insuliinintarve, joka johtuu potilaan
päivittäisestä rutiinista poikkeavista mutta tavalliseen arkielämään kuuluvista toimista. Tällaisia
toimia voivat olla jokin urheilulaji, jota potilas harrastaa kerran viikossa, viikonlopun aikana
muuttuva unirytmi tai hormonaaliset muutokset kuukautiskierron aikana.

Manuaalinen lisäannos - LISÄANNOSVALIKOSSA valittavissa oleva vaihtoehto, kun Bolus Wizard on
käytössä. Yksi tapa ohjelmoida lisäannos ilman Bolus Wizard -toimintoa.

Matala glukoosi - Pumppu hälyttää, jos sensori osoittaa, että käyttäjän verensokeri on yhtä suuri tai
pienempi kuin tämä arvo. Voit ottaa tämän toiminnon käyttöön tai poistaa sen käytöstä.

Mittari - Lääkinnällinen laite, jolla määritetään veressä olevan glukoosin likimääräinen pitoisuus.
Pieni tippa verta asetetaan kertakäyttöiselle testiliuskalle, jonka mittari lukee ja jota se käyttää
verensokeriarvon laskennassa. Mittari näyttää verensokeriarvon milligrammoina desilitrassa tai
millimooleina litrassa (mg/dl tai mmol/l).

Mittaritoiminto - Toiminto, jonka avulla pumppu voi vastaanottaa verensokeriarvot linkitetystä
verensokerimittarista.

Normaali lisäannos - Määritetyn insuliiniyksikkömäärän välitön annostelu.

Perusannos - Pumpun asetus, joka annostelee insuliinia jatkuvasti ja pitää verensokeripitoisuuden
vakaana aterioiden välissä ja yön aikana. Perusinsuliini jäljittelee haiman insuliinineritystä ja kattaa
siten elimistön kaiken aterioista riippumattoman perusinsuliinintarpeen.

Perusannosmallit - Potilas voi ohjelmoida enintään kolme perusannosmallia, joiden mukaan
pumppu annostelee perusinsuliinia: normaali, A ja B. Kuhunkin perusannosmalliin voidaan
määrittää enintään 48 perusannosta.

Perusannosprofiili - Perusannos, jolla on aloitus- ja lopetusaika. Käyttäjä voi ohjelmoida pumppuun
24 tunnin ajanjaksolle useita erilaisia profiileja, joilla on kullakin erilainen perusannos. Näin
glukoosin hallinta on helpompaa.

Perusinsuliini - Insuliinipumpun automaattisesti ja jatkuvasti annostelema tuntikohtainen
insuliinimäärä, joka määräytyy pumppuun esiohjelmoitujen profiilien ja yksilöllisten
annostelunopeuksien mukaan. Pumppu annostelee insuliinia vuorokaudessa määrän, joka
tavallisesti kattaa potilaan tarvitseman perusinsuliinin paaston aikana (kuten yön aikana ja
aterioiden välissä).

Pikalisäannos - Minkä tahansa lisäannostyypin annostelutapa. Pikalisäannos annostellaan pumpun
pikalisäannospainikkeella.

Pysäytys - Pumpun toiminto, joka pysäyttää kaiken insuliinin annostelun. Kaikkien senhetkisten
lisäannosten ja/tai täyttöinsuliinin annostelu peruutetaan. Perusannoksen annostelu keskeytyy,
kunnes pumppu käynnistetään uudelleen.

RF - Radiotaajuus, radiotaajuinen.

Square Wave® -lisäannos - Jatkettu lisäannos, jonka pumppu annostelee tasaisesti määrätyn ajan
kuluessa (ajaksi voidaan määrittää 30 minuuttia–8 tuntia).

Vaihtoannossuhdeluku - Arvo, joka ilmoittaa, kuinka paljon insuliinia tarvitaan yhden (1)
hiilihydraattivaihtoannoksen kattamiseen. (Katso myös ”Hiilihydraattisuhdeluku”.)

Vajaa säiliö -varoitus - Ohjelmoitava varoitus, joka varoittaa pumpun käyttäjää, kun säiliössä on
jäljellä määritetty yksikkömäärä tai kun säiliö tyhjenee määritetyn ajan kuluessa.

VS - Verensokerin lyhenne.

Väliaik. - Väliaikainen.

Väliaikainen perusannos - Väliaikainen kertaluonteinen perusannos, jolle määritetään määrä ja
kesto. Väliaikaisella perusannoksella voidaan kattaa erityisten normaalista päivärutiinista
poikkeavien toimien tai tilojen aiheuttama insuliinintarve.
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